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1: Welcome

Welcome to the I04AB User's Guide. Inside you'll find instructions on how to set up EtherNet/IP™
messaging between an AIIen—Bradley® Logix™ controller and Opto 22's SNAP PAC I/0 using Opto 22's
EtherNet/IP Configurator as well as Allen-Bradley’s RSLogix ™ 5000 software. (For a list of supported
Allen-Bradley platforms, see page 107.)

This guide assumes that you are already familiar with how to use Allen-Bradley's RSLogix 5000
software to configure Allen-Bradley devices.

PLCs

e

\ZNAP PAC EB=series
o,

-

Tt

\SNAP PAC R-series

SNAP PAC S-series

EtherNet/IP automation environment with PLCs and Opto 22
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USING THIS GUIDE

Using this Guide
Chapter 1: Welcome—~Provides information about this guide, where to find additional information,
and how to reach Opto 22 Product Support.

Chapter 2: Introduction to I04AB—An overview of Opto 22's implementation of EtherNet/IP, and
the things you will need to get started.

Chapter 3: Getting Started—How to install Ethernet/IP Configurator, add an Opto_22 device to the
network, and configure /0 modules and points.

Chapter 4: Setting Up Implicit Messaging—How to use EtherNet/IP Configurator and RSLogix 5000
software to set up implicit messaging between an Allen-Bradley controller and Opto 22 remote I/0.

Chapter 5: Setting Up Explicit Messaging—How to use the EtherNet/IP Configurator and RSLogix
5000 to implement explicit messaging.

Chapter 6: Connecting PAC Control and Allen-Bradley Systems—How to connect a SNAP-PAC-S
controller with an Allen-Bradley ControlLogix programmable logic controller (PLC) in order to
exchange data.

Chapter 7: Using EtherNet/IP Configurator—Additional information about EtherNet/IP Configurator
not included previous chapters.

Appendix A: Supported Allen-Bradley Platforms—Lists the Allen-Bradley controllers that support
EtherNet/IP.

Appendix B: Using Counts—Describes using counts with EtherNet/IP and linearizing the Pt100 and
Pt1000 probes from resistance.

Appendix C: Worksheets and Calculations—Provides a variety of worksheets to help you determine
your system'’s requirements.

Appendix D: Connecting with MicroLogix—Provides information for connecting to a MicroLogix
1100 or 1400 PLC.

Appendix E: Detecting /0O Communication Failures—Describes how ladder logic detects an 1/0
communication failure.

Appendix F: Generic Ethernet Module Options—Provides information on selecting a
communications format.

Appendix G: Accessing Serial Data—Describes how to use a SNAP PAC controller to handle the
communication with a SNAP PAC serial module and make the data accessible to an Allen-Bradley
controller.

Documents and Online Help

You may also need the following Opto 22 hardware documentation, depending on your application:

For this information See this guide Form
Installing and using SNAP PAC brains SNAP PAC Brain User's Guide 1690
Installing and using SNAP PAC R-series controllers SNAP PAC R-Series Controller User’s Guide 1595
Installing and using SNAP PAC S-series controllers | SNAP PAC S-Series Controller User's Guide 1592
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http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3166
http://www.opto22.com/site/documents/drilldown.aspx?aid=2772
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=2668

CHAPTER 1: WELCOME

For this information See this guide Form
Using the OptoMMP Communication Toolkit or the
IEEE 1394-based OptoMMP memory-mapped OptoMMP Protocol Guide 1465
protocol for programming
Wiring, specifications, and installation information
for SNAP Analog Input Modules SNAP Analog Input Modules Data Sheet 1065
Wiring, specifications, and installation information
for SNAP Analog Output Modules SNAP Analog Output Modules Data Sheet 1066
Wiring, specifications, and installation information . . .
for SNAP High-Density Digital Modules SNAP High-Density Digital Modules Data Sheet 1556
Wiring, specifications, and installation information -
for SNAP Digital Input Modules SNAP Digital Input Modules Data Sheet 0773
Wiring, specifications, and installation information -
for SNAP Digital Output Modules SNAP Digital Output Modules Data Sheet 1144
er.lng, spemflcatlops, and installation information SNAP Isolated Analog Input Modules Data Sheet | 1182
for isolated analog input modules
erlng., specifications, and installation information SNAP Serial Communication Modules Data Sheet | 1184
for serial modules
Using EtherNet/IP commands with remote
Opto 22 SNAP PAC I/O with an Allen-Bradley® Ethernet/IP for SNAP PAC Protocol Guide 1770

Logix™ controller

Latest release, installation, and system require-
ments information for EtherNet/IP Configurator.

EtherNet/IP Configurator Release Notes.
(See www.opto22.com for the latest form number.)

All documents are available on our website, www.opto22.com. The easiest way to find a document

is to search on its form number.

Additional resources are also available on the Opto 22 Web site such as a demonstration video that
shows how to configure and program an Allen-Bradley controller to talk to SNAP PAC I/O. If you are
viewing this document online and have an internet connection, click the link. Or go to the Learn tab
on the Opto 22 website, www.opto22.com, and click Learn About I04AB.

Additional Resources for EtherNet/IP

For an overview of CIP and EtherNet/IP technology, see
http://www.odva.org/Portals/0/Library/Publications_Numbered/PUB00138R2_CIP_Adv_Tech_Series_EtherNetIPpdf

For information on the network infrastructure for EtherNet/IP, see
http://www.odva.org/Portals/0/Library/Publications_Numbered/PUB00035R0_Infrastructure_Guide.pdf

For a good starting point for Ethernet/IP research on the ODVA web site, see

http://www.odva.org/default.aspx?tabid=67
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http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3672

PRODUCT SUPPORT

Product Support

If you have any questions about using EtherNet/IP to communicate with Opto 22 devices, you can
call, fax, or email Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 NOTE: Email messages and phone
toll-free in the U.S. and Canada) calls to Opto 22 Product Support
951-695-3080 are grouped together and
Monday through Friday, answered in the order received.

7 a.m.to 5 p.m. Pacific Time

Fax: 951-695-3017
Email: support@opto22.com
Opto 22 website: www.opto22.com

When calling for technical support, be prepared to provide the following information about your
system to the Product Support engineer:

Version of this product

PC configuration (type of processor, speed, memory, operating system)
RSLogix 5000 version

PLC model

PLC firmware version

Complete description of your hardware system, including:

- Jumper configuration

- Type of power supply

- Types of I/0 units installed

- Controller firmware version

- Specific error messages

|O4AB User's Guide
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2: Introduction to I04AB

This chapter includes a brief introduction to Ethernet/IP and how it is implemented in Opto 22
products. It also provides guidance in selecting a messaging type.

Built on the standard TCP/IP suite of protocols, EtherNet/IP gets the “IP" part of its name from CIP",
the Common Industrial Protocol . As the name implies, EtherNet/IP adapts CIP to standard Ethernet
technology, and thus provides tools to deploy manufacturing applications on an enterprise
network. Introduced in 2001, EtherNet/IP is now supported by hundreds of vendors around the
world and is a standard networking solution in industrial automation.

In this Chapter

(001 (PN Yo \Yz: T = 1o [N 5
OPO 22 ProAUCES...oooceveveeseeesveessessveesssssess e 6
ATCNITECTUIE oo 7
Implicit and Explicit Messaging ..., 7
Using CIP Objects . . . . 8
Specifications .. . . . . 9

Opto 22 Advantage

Using EtherNet/IP, Allen-Bradley Logix controllers can communicate with remote Opto 22 I/0 and
take advantage of Opto 22's distributed intelligence. With distributed intelligence, a controller (such
as an Allen-Bradley controller), handles overall control but does not have to attend to every detail of
every process. The I/0’s own onboard processor (also called a brain or device) has the intelligence to
handle not only on/off control but also functions such as latching, counting, thermocouple
linearization, even PID loops. With these functions running locally on the I/0 unit, they still do their
job even if communication to the controller is lost, and the load on the controller is reduced.

|O4AB User's Guide



OPTO 22 PRODUCTS

oOPTO 22

Automation made simple.

By connecting to Opto 22 devices as remote |/0, you can add the rich and sophisticated

functionality of Opto 22 equipment to your EtherNet/IP systems. While other manufacturer's devices

may report only states and counts, our SNAP PAC System devices can provide access to the
following functions:

Power consumption

Power line monitoring

PID loop control (up to 96 loops)
Serial device control (RS-232/485)
Analog scaling

Offset and gain

Analog ramping

Output clamping

Filter weight

Minimum and maximum values

Engineering unit conversion

Opto 22 Products

You can use a variety of Ethernet-capable devices from the SNAP PAC family of products in an

EtherNet/IP environment, including the latest generation of SNAP PAC controllers and brains. There

are two basic approaches:

«  Use SNAP PAC I/0 with a SNAP PAC EB-series brain or R-series controller as intelligent remote
I/0 with an EtherNet/IP-enabled scanner such as an Allen-Bradley PLC. If you want a brain or
controller with Factory Mutual approval, choose the part number with FM at the end, such as

SNAP-PAC-EB1-FM.

NOTE: SNAP PAC EB-series brains are equipped with LEDs that report the EtherNet/IP module status
(MS) and network status (NS). For more information, see form 1690, the SNAP PAC Brains User’s Guide.

«  Use SNAP PAC S-series or R-series controllers to exchange scratch pad variable data with an

Thermocouple linearization
Temperature conversion
Quadrature counting

Input latching

Pulse generation and measurement
High-speed counting (up to 20 kHz)
Frequency and period measurement
Digital and analog totalizing
Watchdog timeout
Time-proportional output

Load cell

EtherNet/IP-enabled scanner such as an Allen-Bradley PLC.

n |O4AB User's Guide



CHAPTER 2: INTRODUCTION TO 104AB

Architecture

In EtherNet/IP terminology, a device may function as either an adapter or a scanner. Our Opto 22
devices are implemented as adapters, and as such are able to send and receive data only when
requested to do so by a scanner. The Opto 22 device (or adapter) is therefore a target of instructions
and requests for information sent by a scanner, which is usually a PLC, but could be a PC running
control software.

An adapter class device receives message requests from all other classes of products, and it can
exchange peer data using messages with any class of device. However, an adapter cannot store or
originate the data communications parameters necessary to establish a connection. Therefore, it
cannot originate real-time 1/0 data connections, which is why it sends and receives I/0 data only
when it is requested to do so by a scanner.

A scanner is capable of originating I/0 data connection requests with adapter class products, as well
as with other scanner class products. Scanner class devices may also originate or be the targets of
explicit connection requests to and from other classes of products, and they can send or receive
messages to or from all other classes of products.

Implicit and Explicit Messaging

As adapters, SNAP-PAC-EB brains, and SNAP-PAC-R and SNAP-PAC-S controllers are able to exchange
messages with scanners using both explicit and implicit messaging.

Explicit messages are used for request/response transactions between two nodes. The scanner
sends a request and the adapter returns a response. Using TCP/IP, these messages can reach any
network-accessible object attributes and services within a device. Once the modules and points are
configured on an Opto 22 device, no additional configuration is required on an Opto 22 device. All
programming is done in RSLogix.

Implicit messages transfer data at regular intervals established by the scanner. No request is
required, the request is implied. Implicit messaging connections often are set up as one-to-many
relationships and use UDP/IP to multicast application-specific I/0 data at regular intervals. When
properly configured, the data is always available to be scanned by the controller. In addition to
configuring the modules and points on an Opto 22 device, you must also create input and output
assemblies. An assembly provides the format for the implicit message packet that includes the
information for the point or points you are interested in.

For help with choosing a messaging type, see the next section “Choosing the Messaging Type.”

|IO4AB User's Guide



USING CIP OBJECTS

Choosing the Messaging Type

Implicit messaging is the normal way to communicate with /0. However, there are times when
explicit messaging is more appropriate. See the reasons below for why you might use one
messaging type over the other. All of these apply for a properly configured Ethernet network (wired
or wireless).

Reasons for Using Implicit Messaging

+  For typical communications with I/O (also called [/O messaging) where an item is scanned or
repeated

«  Forasimplerimplementation and less programming in ladder logic. Programming in ladder
logic is required for explicit messaging.

«  Ifyouwant the SNAP I/O to send data at stated intervals to one or more PLCs without waiting
for a request (input instance), or if you want the PLC to do the same (output instance)

For instructions for using implicit messaging, see “4: Setting Up Implicit Messaging”on page 23.

Reasons for Using Explicit Messaging
« Ifyou want the PLC to initiate communication at specific points in your ladder logic
«  Forcommunication among controllers (such as exception, handshaking, and access)

»  For more complex commands that are not suited to scanning. For example, Read and Clear
Counters.

«  Toroute messages over wide area connections. With explicit messaging, you can access a
remote Opto 22 device over the Internet.

«  Forsending or receiving data on a serial communication module port using the Serial Port
object

+  Ifthe quantity of data exchanged exceeds ~1000 bytes of input data or ~500 bytes of output
data, which are the limits in RSLogix 5000 software, the excess must be exchanged via explicit
messaging

«  For some OEM applications, properly configured explicit messaging can require less
programming and program management

For instructions for using explicit messaging, see “5: Setting Up Explicit Messaging” on page 33.

Using CIP Objects

EtherNet/IP accesses device data and functionality as a collection of object attributes and services.
As much as possible, Opto 22 device data and functionality is exposed through standard CIP objects,
extended for additional non-standard functions. In some cases vendor-specific objects are defined
for functionality that is not within the scope of the standard objects.

The classes available for implicit messaging in the EtherNet/IP Configurator are a subset of the CIP
classes, all of which are available through explicit messaging. For information on the CIP classes and
attributes, see form 1770, Ethernet/IP for SNAP PAC Protocol Guide.

n |O4AB User's Guide
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CHAPTER 2: INTRODUCTION TO 104AB

Specifications

The following specifications apply to any SNAP PAC Ethernet-based brain or controller used as a

remote /0 unit for an Allen-Bradley PLC:

TCP/IP encapsulation connections 16
CIP Connections allowed per TCP/IP connection 2
Implicit Multicast Connections 16
Assembly instances supported 16
Assembly members in all assembly instances 4096
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SPECIFICATIONS

|O4AB User's Guide



3: Getting Started

This chapter describes lists the things you will need in order to implement I04AB. It also describes
how to install EtherNet/IP Configurator and two procedures which you must do for both implicit
and explicit messaging: adding an Opto_22 device to the network and configuring I/0 modules and
points.

In this Chapter

What You Will Need...........cooooooccccreeeeeseeccsierreeeee
Installing EtherNet/IP Configurator
Adding an Opto 22 Device...........o....
Configuring I/0 Modules and Points................ 16

What You Will Need

« A SNAP PAC EB-series or R-series device loaded with firmware R8.3a or newer, installed on a
mounting rack with I/0 modules and connected to the network. See the documentation
included with the Opto 22 hardware.

NOTE: If you will be doing the exercises in “5: Setting Up Explicit Messaging” on page 33, and want to
run your example Logix project, you will need a SNAP PAC Learning Center from Opto 22, either part
number SNAP-IO4ABLC or SNAP-PACLC. However, if you do not plan to run your example project, you
do not need a Learning Center.

Make sure to assemble the Learning Center according to the instructions that are included. For more
information about obtaining a SNAP PAC Learning Center, go the Opto 22 website, www.Opto22.com
and search on the part number.

+  EtherNet/IP Configurator installed on your computer (see below). EtherNet/IP Configurator is
available as a free download from our website, www.opto22.com, and it is included with the
(D that came with the Opto 22 device.

«  RSLogix 5000, version V13 or newer installed on your computer

+  ControlLogix PLC 1756-L6x with a 1756-ENBT/A, 1756-EN2T, or 1756-EM2F EtherNet/IP
module. You can also use a CompactLogix 1769-L32E, a DriveLogix 700s Version 2, or a
SoftLogix.
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INSTALLING ETHERNET/IP CONFIGURATOR

NOTE: If you have a Micrologix 1100 or 1400 (Series B FRN4 or newer), you can also connect the two
systems and use Explicit Messaging to access data. For more information, see “D: Connecting with
MicroLogix”on page 121.

»  Anindustrial managed Ethernet switch

Installing EtherNet/IP Configurator

The easy-to-use EtherNet/IP Configurator provides the tools you need to configure modules and
points, create input and output assemblies, and download a configuration to an Opto 22 device.

EtherNet/IP Configurator is available as a free download from our website, www.opto22.com, and it
is included with the CD that came with your Opto 22 device.

If you are using the download, double-click the downloaded file. The installation wizard should
start automatically. Follow directions to install the software.

If you are using the CD, insert the CD in your CD-ROM drive. The installation wizard should start
automatically. If it doesn't, use Windows Explorer to navigate to your CD-ROM drive and then
double-click setup.exe. Follow directions to install the software.

Adding an Opto 22 Device

The best way to add an Opto 22 device to the network (and also the configuration) is to allow
EtherNet/IP Configurator to discover the device. (To add a device manually, see “Adding a Device
Manually”on page 78.)

Perform the following tasks to open EtherNet/IP Configurator and add an Opto 22 device.

1. Toopen EtherNet/IP Configurator:

— InWindows 7 and Windows Vista, press the Windows Start key €) and then click
Programs > Opto 22 > PAC Project 9.6 > EtherNet-IP > EtherNet-IP Configurator.

- InWindows 10 and Windows 8.1, press the Windows Start '@3‘ type EtherNet-IP
Configurator 9.6 and then press the Enter key.
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PAC R2 Cookies™ - EtherNet/IP Configurator
Edit Tools ‘iew Help
W ?
= Add new device... 5
=1 SHAP_PAC_R. Configure /0 Modules & Points | Canfigure PID Loops} Canfigure Assembhes} Verify }
10.162.65.116
SHAP-PAC-R1 tdodules and Points | Type ‘ Feature / Scaling | Units ‘watchdog
=I-SMAP_PAC_EB Add..
10.152.65.118
SMAP-PAC-EBL
- Discovered Devices Q
00-AD-3D-00-C1-45
00-A0-3D-01-51-D8
00-A0-30-01-51-DF Expand Al
00-A0-30-01-09-7C
Collapze All
4 3
Ready MM

When installed and first turned on, an Opto 22 device sends out a BootP broadcast requesting an IP
address. EtherNet/IP Configurator discovers each Opto 22 device on your network broadcasting a
BootP request and lists the devices in the device tree.

Discovered Devices —ft—

EIF EtherNet/IP Configurator - Delta

File Edit Tools WYiew Help

O %

+- Opto 22 1}
—|- Discovered Devices
00-A0-30-00-C1-45
00-A0-30-01-51-D8
00-A0-30-01-51-DF

MAC addresses

Like all Opto 22 Ethernet-based controllers and brains, each of the discovered devices has a unique
hardware Media Access Control (MAC) address, which is displayed in the device list.

In order to add a discovered device to a configuration so that it can communicate on the network,
you must give the device a name, a valid IP address, and a subnet mask.

To add a discovered device:

1.

Make sure the device is connected to the network and turned on.
The device now broadcasts a BootP request for its configuration.

Your SNAP-PAC-EBT is identified by its MAC address, also written on a label attached to the side
of the controller's housing. (The MAC addresses of Opto 22 devices begin with 00.a0.3d.) If no
devices are listed under Discovered Devices, turn your Opto 22 device off and then turn it on
again.

When the MAC address of the discovered device appears under Discovered Devices,
double-click the MAC address.
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8 |Untitled® - EtherNet/IP Configu
File Edit Tools Yiew Help

O=E ?

-1 Add new device...
+- Unnamed_Device
Discovered Devices
f0-3 ‘||:|-u::1.:}:5:
0o0-A0-30-01-51 BF
0o0-A0-30-01-51-E4

CAUTION: EtherNet/IP Configurator lists ALL Opto 22 devices sending BootP or DHCP broadcasts.
Assign IP addresses only to the ones you know are yours!

The Assign IP Address dialog box appears.

Assign IP Address to 00-A0-3D-00-C... fz|

IP Address: [ B .0 o .0
SubretMaske. | 0 . 0 . 0 .0
Gatewa_l,lAddless:l o .0 o .o
DNSAddesss | 0 . 0 . 0 . 0

ak. | Cancel |

3. Enter the IP Address and the Subnet Mask for the device. If it will be talking to a device on
another subnet, enter the Gateway (router) address. If it will talk only on the local subnet, leave
the gateway address all zeros (0.0.0.0). Leave the DNS address at 0.0.0.0 field blank.

WARNING! Each device on your network, including computers, routers, controllers, brains, and so on,
must have a unique IP address. Failure to assign unique IP addresses may cause catastrophic network
or hardware failures. If you don't know which IP addresses are safe to use, check with your system
administrator.

4, When the IP address, subnet mask, and other fields are correct, click OK.
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The Name This Device dialog box appears with the Device Type, IP Address and Port filled in
automatically.

Name This Device [5__<|

Device Mame: |

Description: |

Device Type: | J

IP &ddress: |

Port:

Temperature:  © Fahrenheit Celsiug

W atchdog: * No  Yes

(1]4 | Cancel |

At minimum, enter a Device Name.

You can also enter a description, select the temperature type, and whether you want to use a
watchdog.

Temperature. Choose whether temperatures will be handled in Fahrenheit or Celsius.

Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled). If
you select Yes, a new field appears; enter the Watchdog timeout value (in seconds). The default
timeout is 0.5 seconds.

NOTE: Ifyou want to enable Watchdog on a point, make sure to enable it here at the point level as well.

Click OK to confirm the changes.

The new device appears in the device tree.

EIF System IV* - EtherNet/IP Config

File Edit Tools vYiew Help

L=EE 7
—I- Add new device...
+- Unnamed_Device

New device —|

Discovered Devices
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Configuring I/0 Modules and Points

For both implicit and explicit messaging, once you have added a device, you need to configure its
modules and points as described in the following sections:

«  “Configuring Digital Points” (below)
«  "Configuring Analog Points”on page 19

Configuring Digital Points

Use the following steps to configure digital points on all 4-channel and high-density SNAP digital
modules.

1. In EtherNet/IP Configurator, click the Configure I/0 Modules & Points tab.

#2 Untitled - EtherNet/IP Configurator,

Flle Edit Tools Wiew Help
Ow=E 7
- Add new device... - -
+ Unnamed_Device Canfigure |f"':%0dU|BS & Paints l Configure PID Loopsl Configure Aszzemblies ] Werify ]
-|- Discovered Devices
00-A0-30-01-75-B9 Modules and Points Tyvpe o
Add...
Expand Al
Collapsze all
1 B
Ready MM

2. Double-click the number that represents the digital module’s position on the rack. For help, see
“Referencing I/0 Points on SNAP PAC Racks”on page 106.
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& Add Module

Dpe:

Dvigital Qutput
Analog Input
Analog Output

h ~|DCE: 10 C
SHAPDCE-FAST: 25- 16D
SHAPDCE-FAST -4 18 - 32WDC

SHaPDCED: 25 - 28%DC

SHAPDCEMA: 10 - 32 WDCAALC Mandduto Switch
SHAP-DCE-SW: Dy Contact Switch

SHAP-IDCEN: 4 - 24DE

SHAPDCEG: 35 - 7R WACADC

SHAPDCE-HT: 15 - 32VDC

SHAP-DCE-5W-MC: Dy Contact Switch
SHAPDCEFM: 10 - 32 WDE

SHAPDCEDFM: 25 - 28vDC

SHAPDC-32 10 - 32vDC

SHAPIDC-16: 10 - 32WDC

Genenc Digital Input

SHAP-IACE: 90 - 140%DCAMLC

SHAP-IACSA: 150 - 280 VDCAMMLC

SHAP-LACEMA: 90 - 140WDCAAC Man bt Switch
SHAP-IACEFM: 90 - 140 VDCAAC

SHAP-IACRAFM: 180 - 280 VD CAAC

SHAP-IAC-16: 90 - 140%DEAAE

SHAP-AC-A-16: 180 - 280 WDCAMLC

ak. | Cancel |

]

In the Add Module dialog box, choose the module type and then the exact module part

number from the lists. Click OK.

Back in the Configure I/0O Modules & Points tab, click the plus sign next to the new module to
expand it. Notice that the module icon is color-coded to reflect the type of module being
configured: white for digital DC input, red for digital DC output, yellow for digital AC input, and

black for digital AC output.

Canfigure 1/0 Madules & Paints ] Configure PID Loops | Configue Assemblies | Verify |

tdodules ahd Paints Type

— AP-|DCE: 10 - ) ) Crigital Input

Features /£ Subty.. | Unitz En.

Delete

Modify

Expand all

Collapse all

B Bl

|IO4AB User's Guide



CONFIGURING 1/O MODULES AND POINTS

5. Double-click the point you want to configure to open the Add Digital Point dialog box.

Add Digital Point x]

Mame: | — A
Drescription: | —B

Type: —= C
Module: | J

Features: | Hione D
“Watchdog: + No E

QK | Caticel | Help

6. Complete the fields as follows:

A

Name: Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

Description: (Optional) Enter a description of the point.

Type, Module: Type and module are already filled in for you.

Features: To use a feature of the module, choose it from the drop-down list. For information
about the available features, see “Using I/0O Point Features” on page 104.

Watchdog: (Output modules only) To configure a status (On or Off) the point should be set
to if the Watchdog timer on this device expires, click Yes and choose On or Off from the
drop-down list. In order for this to take effect, make sure Watchdog is enabled at the device
level. To do this, double-click the device in the device tree to open the Modify Device
Information dialog. Select Yes for Watchdog, choose a timeout, and then click OK.

7.  When you have completed the fields, click OK.

The new point appears in the list.

Configure 1/0 Modules & Paints ] Configure PID Loops] Configure Aszemblies ] Werify ]

todules and Points | Type | Features / Subty. . | Uritz | En
- [3 [00] SMAP-IDCE: 10 - 32 WDLCAAC Digital Input |
0 Pump_1_Status I IR .
Delete

todify

Expand Al
Collapse Al

8. To configure more digital points, repeat the steps. To configure analog points, see the next
section.
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Configuring Analog Points

Use the following steps to configure analog points on all SNAP analog modules supported by the
device.
In the Configure I/0 Modules & Points tab, double-click the number that represents the analog
module’s position on the rack. For help, see “Referencing /O Points on SNAP PAC Racks” on

1.

2.

Module icon

Expand or collapse points
on the module by clicking
the + or - sign in the box.

Points

page 106.

& Add Module

Tope:

X

Drigital Input
Digital Output

Analog Output

Module:
SHAP-AIARMS

ShAP-AIARMS-
SMAP-AICTD
SNAP-AICTD-4
SMAP-AICTD-E
SMAP-AILT
ShAP-AILC-2
SRAP-AIMA,
SRAP-AIMA
SHAP-AIMA-SRC
SRAP-AIMA-4
SRAP-AIMA-B
ShAP-AIMA-32
SRAP-AIMAZ-
SRAP-AINY-4
ShAP-AIMYZ-4
ShAP-AIPM
ShAP-AIRATE
SHAP-AIRTD
ShAP-AITM
SMAP-AITM-
SHAP-AITMZ
SMAP-AITMZ-

o]

Cancel |

|

4

In the Add Module dialog box, choose Analog Input or Analog Output, and then choose the
exact module part number from the list. Click OK.

In the Configure I/0 Modules & Points tab, click the plus sign next to the new module to

expand it. Notice that the module icon is color-coded to reflect the type of module being
configured: blue for analog input, green for analog output.

Configure |/0 Modules & Paints ] Configure PID Loops] Configure Assemblies] ety ]

Modules and Paints

|Type

| Features / Subty... | Unitz

| -

= |j [00] SHaPIDCE: 10 - 32VDCASAC
L ) Pump_1_Status

_—\. [01] SHAP-AI-§
s

Digital Ibput

Analog Input

4. Double-click the point you want to configure.

MNaone
Delete

odify

Expand &l

B Bl

Collapze Al
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Add Analog Point X
Mame: I — 1A
Description; | - 1 B
Type: = d
Module  |SMAP-AIY-: -10- +10%DC Ed

[ Units: s E
D Zero Scale: |10 j

| | Full 5cale: |10 j_ F

Watchdog, & No G

QK | Cancel | Help

5. Complete the fields as follows:

A Name:Entera name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. (Spaces are converted to underscores.)

B Description: (Optional) Enter a description of the point.

C Type, Module: Type and module are inserted for you. You may be able to choose a different
range from the drop-down list.

D Units, Scale: Units and scaling for this module. See “Using Custom Scaling”on page 21.

E Scaling Default: To return the unit’s zero-scale value and full-scale value to the defaults for
the module, click Default.

F Scaling Custom: To assign custom units and values to the module, click Custom. For
example, you could scale the voltage range of a -10 to +10 VDC module to be interpreted
as engineering units of liters per second instead of volts. See “Using Custom Scaling”on
page 21.

G Watchdog: (Outputs only.) To configure a value this point should be set to if the Watchdog
timer on this device expires, click Yes and enter the value. In order for this to take effect,
make sure Watchdog is enabled at the device level. To do this, double-click the device in the
device tree to open the Modify Device Information dialog. Select Yes for Watchdog, choose
a timeout, and then click OK.

6. When you have completed the fields, click OK.
The new point is added.
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Configure 1/0 Modules & Paints | Configure PID Loops ] Configure Aszemblies ] Werify ]

Expand Al

0 Floweter_&

10 - +10%DC

Collapse Al

todules and Points | Type | Features / Subty. . | Uritz | -
- [3 [00] SHAPADCE: 10 - 32 WDCAMAC Diigital Input
}"T—'_‘" 0 Pump_1_5tatusz Mome
Delete
todify
- . [01] SHAP-AI- Analag Input

Point types and features are shown in the Features/Subtype column.

7. Toadd more analog points, repeat the steps. To add digital points, see “Configuring Digital
Points”on page 16.

Using Custom Scaling

Analog modules can be set to show something other than the actual inputs or outputs. For
example, you could scale the readings of a-10 to +10 VDC input point to measure its input as zero
liters per second when the real-world reading is zero VDC, and 1000 liters per second when the
real-world reading is five VDC.

NOTE: Custom scaling has no effect on the resolution or accuracy of the module.

1. Inthe Add Analog Point dialog box, click the Custom button in the Scaling area to open the
Scale Analog Readings dialog box.

§| This example shows units scaled to liters
—4 persecond. At an actual input of 0 VDC,

A | Scaled Units: [Liters per second the point will show 0 liters per second.
Atanactualinputof 5 VDC, the point will

Scale Analog Readings

Lower Value show 1000 liters per second.
B——1— 4ctua |0 [vOC
C —1! Scaled |D |Liters PEr SECO
Upper Yalue
D— scuat |5 VDT
E— scaked |1 ujuli] |Liters pEr gEcn

QK | Cancel | Help |

2. Complete the fields as follows:

A Scaled Units: Enter new engineering units for the module. The example uses liters per
second.

B Actual Lower Value: Enter the actual real-world lower value that the scaled lower value
corresponds to. Note that inputs typically have under-range capability, which means you
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Add Analog Point

can specify a lower actual value that is less than the zero-scale value. Outputs do not have

under-range capability.

value.

Scaled Lower Value: Enter the new scaled lower value. This value can be any floating point

Actual Upper Value: Enter the actual real-world upper value that the scaled upper value

corresponds to. For inputs, you can specify an upper actual value greater than the full-scale

value.

Scaled Upper Value: Enter the new scaled upper value. This value can be any floating point
value greater than the scaled lower value. This example uses 1000, which scales the output
to 1000 liters per second when its actual reading is 5 VDC.

3. (lickOK.
The new custom-scaled units appear in the Add Analog Point dialog box.

X

Mame: |FIOwmetel_A
Description: |
Type:
Module:  |SMAP-AIE 10-+10VDC (Scalable] |
. - Scaling
Units: Liters per second
Drefault
Zero Scale: |-2000 \-\
Cusztomn...
Full Scale: 2000 _
Watchdog: & Mo
Ok Cancel Help

Notice the new units of liters per second and the
new minimume-scale (“Zero Scale”) and
maximum-scale (“Full Scale”) values of -2000 and
+2000. The example connects a sensor with a
range of 0-1000 liters per second, but an output
of only 0-5 volts, to a SNAP-AIV module with an
output of -10 to +10 volts. The figures shown in
this dialog box reflect the total possible range of
the module, not the sensor.

Custom scale Module’s
(Liters/sec) scale (VDC)
L Possible low -2000 =10
value for
module
-1000 -5
Upper & lower 0 = 0
values entered 1000 _ 5
in dialog box
Possible high 2000 10
value for
module

NOTE: On a bipolar module (for example, -10 VDC to +10VDC), the minimum scale is always zero EU,
not a negative number.
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4. Setting Up Implicit
Messaging

This chapter describes how to use EtherNet/IP Configurator and RSLogix 5000 software to set up
implicit messaging between an Allen-Bradley controller and Opto 22 remote 1/0. If you want to set
up explicit messaging, see “5: Setting Up Explicit Messaging” on page 33. For help in choosing a
messaging type, see “Choosing the Messaging Type”on page 8.

Before you begin, make sure you have done the following things:

« Installed your Opto 22 device and modules according to the instructions that came with the
device and modules

+  Added your Opto 22 device using EtherNet/IP Configurator (see “Adding an Opto 22 Device”on
page 12)

»  Configured the Opto 22 1/0 module and points (see “Configuring I/0 Modules and Points”on
page 16)

To set up implicit messaging you must use EtherNet/IP Configurator to create input and output
assemblies. An assembly provides the format for the implicit message packet that includes the
information for the point or points you are interested in. Once you have created the assemblies you
will use RSLogix 5000 to complete the setup.

For a list of the basic things you will need, see “What You Will Need" on page 11.

In this Chapter
Creating an Input Assembly ... 24
Creating an Output Assembly ........ooocccvvrreciveee 26

Configuring RSLogix for Implicit Messaging ...28
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Creating an Input Assembly

1. In EtherNet/IP Configurator, click the Configure Assemblies tab, and then select an assembly
instance number, for example assembly instance 100. Each assembly instance created requires
a unigue number. Unused assembly numbers have a white background.

Configure 120 Modules & F'Uints] Configure PID Loops  Configure Assemblies lVerif_l,l ]

Azzembly [nstahce: 100
|'IDD 100 | 102103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 | 117 ) 112 113 ] 114
Desc%l

Azsembly Members:

# | DINT | Bit | Size | Class | Instance

ion;

|
o

el f

[ ~ AFT AL

2. (lick Add to open the Add Assembly Member dialog box.

Add Assembly Member

X

Description;

Class: Instance |nformation: Athribube:
D e |mput Point

Dizcrete Output Paint " Point Name FeatureSelect
Analag Input Paint FeatureEnable
Analog Dutput Paint | J Featur/alue
Laad Cell Input ClearFeaturstalue
Scratchpad DIMNT OnLatch
Scratchpad REAL OffLatch
Seratchpad STRING Madule: |0 =l

3
Pulze And TPO Generator 2
Famp Controller Paint. |0 :"
FID Loop Contraller

Communication watchdag
Pad

0K | Cancel |

3. Select a class such Discrete Input Point.

The classes available for implicit messaging in the EtherNet/IP Configurator are a subset of the
CIP classes, all of which are available through explicit messaging. For information on the CIP
classes and attributes, see form 1770, Ethernet/IP for SNAP PAC Protocol Guide.
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4,

5.

6.

7.
8.

o.

CHAPTER 4: SETTING UP IMPLICIT MESSAGING

Under Instance Information, select a point that you have configured. Otherwise, you can assign
an assembly member to a specific module and point.

Add Assembly Member fg|
Description:
Clags: Instance Information: Abtribute:
|nput Point

Digcrete Output Point * Poirt Name FeatureS elect
Analog Input Point FeatureEnable
Analog Dutput Paint |Ph0tg Sersor [Mod00 F't'Dj Featurgalue
Load Cell Input Eh 3 ModDaSrnT ClearFeaturetfalue
Scratchpad DINT ' (Ml J OrLatch
Seoratchpad REAL . OffLatch
Scratchpad STRING Module: =l

Pulze And TPO Generator 2
Famp Controller Faint: :l
FID Loop Contraller

Communication W atchdag
Pad

0K | Cancel |

Under Attribute, select an item in the list.

The attribute list allows you to define what information from each point you want to have
passed in the implicit message. In addition to value readings, you can get other data, such as
the minimum or maximum value for an analog input/output.

Click OK and follow any directions that appear for the class.

For example, the Fill Module dialog box appears for Discrete Input Point and Analog Input
Point.

Fill Module

Wwhould pou like to fill the rest of the module with the zame type of point?

* Yez " No

How mary points does this module have? |4 -

Click OK.
Continue to add elements as necessary.

NOTE: If an assembly member or group of members adds up to less than 32-bits, you will need to add
padding.

To add a pad, click the Add button to open the Add/Modify dialog box.
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10. Under Class, select Pad, enter the size of the pad (for example, 28), and click OK.

Add Assembly Member §|

Drescription:

Class:

Inztance |nformation: Attribuite:

Dizcrete Input Point
Digcrete Output Point Size In Bitz: |28
Analog Input Point
Analog Output Point
Load Cell Input
Scratchpad DINT
Scratchpad REAL
Scratchpad STRING
Pulze And TPO Generator
Ramp Contraller

PID Loop Controller

Communication Watchdoi
Qk. | Cancel |

The pad appears as the last member of element 0 to complete the 32-bit word, also called a
DINT. You can add up to 125 input DINTs.

When you have completed an input assembly for implicit messaging, go to the next section to
Create an output assembly.

Creating an Output Assembly

Creating an output assembly is similar to creating an input assembly.

1. Onthe Configure Assemblies tab, click an assembly instance number other than the one used

for the input assembly, for example assembly instance 101.

Notice that the assembly numbers you've already used have a green background.

Configure 1/0 Modules & F'Dints] Configure PID Loops  Configure Assemblies l Yerify ]

Azsembly Instance: 101

m%mz 1023 [ 104 [ 105 [ 106 [ 107 [108 [ 109 [ 110 [ 111 [ 112 [ 113
o]

ezcription;

Agsembly Members:
# | DINT | Bit | Size | Class

Instance

2. Selecta class such Discrete Output Point.

The classes available for implicit messaging in the EtherNet/IP Configurator are a subset of the
CIP classes, all of which are available through explicit messaging. For information on the CIP
classes and attributes, see form 1770, Ethernet/IP for SNAP PAC Protocol Guide.
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Under Instance Information, select a point that you have configured. Otherwise, you can assign
an assembly member to a specific module and point.

Under Attribute, select an item in the list.

Add Assembly Member

Description;

%]

Class: Instance Information:

Digcrete Input Point

Cutput Point {* Paint Marme

Analog Input Pairt

Analog Output Point |Uutside_Light Mod:01 Pt:Diﬂ
Load Cell Input = _
Scratchpad DINT X k
Scratchpad REAL _

Scratchpad STRING Module: |1 -]

Pulze find TPO Generator .

Famp Controller Faint l—_|

PID Loop Controller
Communication 'Watchdog
Pad

=]

Cancel |

Attribute:

Comm'atchdogE nable
Commatchdogh alue

The attribute list allows you to define what information from each point you want to have
passed in the implicit message. For example, in addition to writing a value to a point, you might
want to change the watchdog value or set high or low clamps on an analog point.

NOTE: If an assembly member or group of members adds up to less than 32-bits, you will need to add

padding.

5. Toadd a pad, click the Add button to open the Add/Modify dialog box.
Under Class, select Pad, enter the size of the pad (for example, 28), and click OK.

6.

Add Assembly Member

Description:

X

Clazs: Instance Information:

Size In Bits: |28

Dizcrete Input Point
Dizcrete Output Point
Analog Input Point
Analog Output Point
Load Cell Input
Scratchpad DINT
Scratchpad REAL
Scratchpad STRING
Pulze And TPO Generatar
Framp Controller

PID Laop Contraller

Carmmunication Watchdoi
ak |

Cancel |

Attribute:

The pad appears as the last member of element 0 to complete the 32-bit word (or DINT). You

can add up to 124 output DINTs.
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When you've completed the output assembly instance, you are ready to download the
configuration to the Opto 22 device. This is also a good time to save the configuration.

7. Tosave the configuration, choose File > Save As. Then browse to an appropriate directory,
name the file (for example, Opto_lO), and then click Save.

8. Before you download the configuration, it is helpful to check for errors on an assembly
configuration report:
a. Inthe device tree, select an Opto 22 device.

‘. EtherNet/IP Configurator - Opt

File Edit Tools Yiew Help
(= = ?

-1 Add new device...

Select an N
Opto 22 device + - SMAP_Pach
+- SMAP_PAC_S1
- Discovered Devices
00-AQ-30-00-90-F5

b. From the Tools menu, choose Assembly Configuration Report. A text file opens showing
the configuration report.
9. Tosend the configuration to the device, choose Tools > Download Configuration to Opto 22
Device.
10. In the Download Configuration dialog box, select the device's IP address, and then click
Download.

Download Configuration to Opto 22 Device f‘5_<|

Download |
Clear Settings

Close

Mame | Description | Port

Address List
Opto_22_[RIO 2001 ]

1921

Timeout [mzec):

| s [1o000

|1

This completes the setup of the Opto 22 remote I/0 for implicit messaging. In the next section, you
will configure communications with the Allen-Bradley controller.

Configuring RSLogix for Implicit Messaging

In this section you will use RSLogix 5000 to configure an Ethernet-enabled Allen-Bradley controller
to communicate with the remote Opto 22 I/0 you configured in the previous sections. The
following instructions show screens from version 17 of RSLogix 5000 software using a
CompactlLogix 1769-L32E PLC.

1. Open RSLogix 5000.
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Select File > New.

On the New Controller dialog box, fill in the appropriate information for the Type, Revision, and
Name fields.

Mew Controller fgl

Yendar: Allen-Bradley

Type — 1 L= |1?89-L32E CompactlogisG332E Contraller j 0K |
Revision — FRewisian: 17 - Cancel
I~ Help

Name — Mame: 10428

Descrption;

Create In: |C:\F|SLogix BO00%Projects Browse.

Browse to the folder you want to use, and then click OK.

In the controller organizer, expand I/0 Configuration, Backplane, and 1769-132E Ethernet Port
LocalENB.

+ I—H% 3LEIYs
L add-on-Defined
+- L Predefined
[ Module-Defined
[T Trends
=15 140 Configuration
Expand< -] m Backplane, CompactLogix Syskem
ﬁl 1709-L32E IO4AE
-4 1769-L32E Ethernet Port LocalEn,
== Ethernet
0 CompactBus Local

| #
W
|

Right-click Ethernet and select New Module.
This module will be used to add the Opto 22 device.

Expand Communications in the controller organizer to open the Select Module dialog box.
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I Select Module f‘5_<|
todule Description Wendor

1769-L32E Etherme.. 10/100 Mbps Ethernet Port on CompactLogixS332E Allen-Bradley »

1769-L35E Etherme.. 10/100 Mbps Ethernet Port on CompactLogixS335E Allern-Bradley 1
1788-ENZDM/ A 1788 Ethernet ta DeviceMet Linking Device allen-Bradley
1788-ENETSA 1788 10/100 Mbps Ethernet Bridge, Twisted-Pair Madia allen-Bradley
1783-E\WEE/A 1783 10/100 Mbps Ethernet Bridge w/Enhanced Web Serv., Allen-Bradley
1794-AENT /A 1794 10/100 Mbps Ethernet Adapter, Twisted-Pair Media  Allen-Bradley
1704-AENT/B 1794 10/100 Mbps Ethernet Adapter, Twisted-Pair Media  Allen-Bradley
Drivelogix5730 Eth... 10/100 Mbps Ethernet Port on DrivelogixS730 Allen-Eradley
ETHERMET-ERIDGE  Generic EtherhetfIP CIP Bridge Allen-Eradley
ETHERMET-MODULE Generic Ethernet Module k Allen-Bradley

Ethertet/IP SoftLogix5a00 EtherietyIP Allen-Eradley —
PH-PSSCEMASA Ethernet Adapter, Twisted-Pair Media Parker Hannif

+|- Digital b
EI| ol

Find. | AddFavore |

By Categary By Wendar J Favarites I

8. Scroll down to Generic Ethernet Module and then double-click it to open the New Module
dialog box.

New Module @

Type: ETHERMET-MODIJLE Generic Ethernet Module
Vendar: Allen-Bradley
Parent: LocalEME
Name: ]SNAF‘_IHID Connection Parameters
Azzembly .
Dezcription: Instance: Size:

Imput: 100 2 _IQ [32-kit)
Output: m 1 3 [32+it)
Carnm Format:IData -DINT L] . ; = -
= Configuration: [254 10 :|. 8-bit
Address / Host Name = =il

© IPaddess | 192 . 168 . 0 . 1 T I
™ Host Mame: | tattis H Ukt I—

W Open Module Properties a4 | Cancel J Help

9. Enter or select the following information:

Name: An appropriate name such Opto_IO.

Comm Format: Choose the format most appropriate for the implicit message data, usually
Data - DINT or Data - REAL.

NOTE: Once you select the Comm Format and then click OK, it cannot be changed.

IP Address: IP address of the Opto 22 device.

10. For the Input Assembly Instance and the Output Assembly Instance, enter the assembly
instance numbers you configured for the input and output assemblies in EtherNet/IP
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Configurator. For example, you might have used 100 for the input assembly and 1071 for the
output assembly.

For the size of the input and output assemblies, enter the number of 32-bit words defined for
each. For example, if you entered one 32-bit word for the input assembly in EtherNet/IP
Configurator as shown here, you would enter 1 as the size of the input assembly on the New
Module dialog box in RSLogix 5000.

Configure |/0 Modules & Paoints ] Configure PID Loops  Configure Assemblies ]Verify ]

Aszzembly Instance: 100
QU I 102 103 | 104 | 105 | 106 | 107 | 108 [ 109 | 110 111 ) 112 1113 1141

Description:

Aszsembly Members:

#t | DINT | Bit | Size | Class | Instance | Athibute

0 0 ] 1 Dizcrete Input Point Flowmeter Mod:00 PEO0D Yalue
1 ] 1 il Pad

The following example assembly from EtherNet/IP Configurator has three 32-bit words, so you
would enter a size of 3 in RSLogix 5000.

Configure 1/0 Modules & F'oints] Configure PID Loops  Configure Assemblies l Werify ]

Agzembly Instance: 100
(RIS XN 102 |03 ] 104 [ 105 [ 106 [ 107 [ 102 103 [ 110 | 111 | 112 [ 113 [ 114 | 118

Dezcription;

Azzembly bembers:

t | DINT | Bit | Size | Class Instance Attribute

1] 1] 0 1 Dizcretel nputPoint Photo_Sengor Mod:00 P Walue

1 a 1 Kil Pad

2 1 0 32 AnalaglhputP airt Store_Termperature Mod:0...  Malue

3 2 0 32 Dizcretel nputPoint Emergency_Switch Mod:0...  FeatureValue

EtherNet/IP Configurator indicates the size of the assembly instance at the bottom of the
screen as shown here.

|IO4AB User's Guide
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Azzembly Instance: 100
102 [103 [ 104 [ 105 [ 106 [107 [108 (109 [ 170 [ 111 [ 112 [113 [ 114 [1
Drescriptior:
Azzembly Members:
# | oiNT | Bit | Size | Class Instance
0 1] 0 1 Digcrete0utputPoint Alam Mod: 01 PLOC Add
1 0 1 1 DigcretelutputPoint Freezer_Door_Statu
2 0 2 1 Discretel utputPaint Inside_Light Mod:0 Delete
3 0 3 1 Digcrete0utputPoint Outzide_Light Mod:
L] 1] 4 28 Fad b oddify
5 1 i] 16 AnalagDutputPaint Fuel_Display Mad:0
g 1 16 1B Pad =
7 2 0 32 DigcretelnputPoint Mod:00 P00 =
4 ¥

Size of assembly———— Instance Size: 3 DINTs [125 Max)

instance

11.

12.

13.

14.

Configure 140 Modules & Points] Configure PID Loops  Configure Assemblies ]\-’erif_l,l ]

For the Configuration fields, enter 254 for the Assembly Instance and 0 for the size.
These Configuration values are not used, but they must be entered.

NOTE: The Input Instance is an RSLogix READ assembly, and the Output Instance is an RSLogix WRITE
assembly. The Configuration values are not used, but they must be entered.
Click OK.

The Module Properties dialog box opens showing the Connection tab for you to enter the
Requested Packet Interval (RPI). The RPI is basically the scan time of the Opto 22 device.

Set the RPI to a reasonable value (range is 10-3200 ms), then click OK.

The Opto 22 remote I/O has now been configured and added to the RSLogix 5000 software as a
generic Ethernet module.

Select Communications > Download to download the RSLogix program to the controller, and
then click Download in the next two dialog boxes that appear.

Once the download is complete, the program will run automatically on the controller.
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Messaging

This chapter describes how to use the EtherNet/IP Configurator and RSLogix 5000 to implement
explicit messaging over EtherNet/IP in order to access data from SNAP PAC I/0 and SNAP PAC
controllers. If you want to set up implicit messaging, see “4: Setting Up Implicit Messaging”on
page 23. For help choosing a messaging type, see “Choosing the Messaging Type”on page 8.

Opto 22's implementation of Allen-Bradley’s explicit messaging is an EtherNet/IP version of an
earlier messaging protocol, CIP Messaging over ControlNet. Similar in some ways to explicit
messaging, CIP messaging also used the MSG instruction. Along with implicit messaging, explicit
messaging is supported on controller platforms such the ControlLogix” and CompactLogix™. It is
also supported on other Allen-Bradley platforms that do not support implicit messaging.

For information on the objects available using explicit messaging in an I04AB system, see form
1770, Ethernet/IP for SNAP PAC Protocol Guide.

For a list of the basic things you will need, see “What You Will Need”on page 11. Note that the
examples in this chapter are based on the I/0 contained in a SNAP PAC Learning Center. It is not
required that you have a Learning Center to do the majority of the steps. However, if you want to
obtain a SNAP PAC Learning Center in order to run your Logix project and exchange data with
Opto 22 1/0, go the Opto 22 website, www.Opto22.com and search on the part number, either
SNAP-I04ABLC or SNAP-PACLC.

In this Chapter

Creating an Assembly INSTANCE .....ovovvvvrescereessssreesssssee s 34
Configuring an EtherNet/IP Module ... 40
Creating @ MESSAGE ODJECT ..o 43
Adding the MSG INStrUCHION ..oooccvveeeecreeeseeeeesseee e 50
Configuring a MSG to Write an Assembly Instance....... 52
Using User Data Types (UDTs) ... ) ) ceeeeeeeeesenan 54
Summary... . . s 55
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CREATING AN ASSEMBLY INSTANCE

Creating an Assembly Instance

This section provides an example of how to use EtherNet/IP Configurator to configure modules and
points on an Opto 22 device such that the data can be accessed by the Allen-Bradley Logix
architecture.

This section includes the following topics:

+  “Using EtherNet/IP Configurator to Add and Configure a SNAP-AICTD Module” on page 34
«  "Configuring the SNAP-AICTD Module Input Assembly”on page 36

+  “Configuring the SNAP-AOV27 Module Output Assembly”on page 38

+  “Downloading the Configuration to the SNAP PAC I/O Unit."on page 39

Using EtherNet/IP Configurator to Add and Configure a
SNAP-AICTD Module

In this section you will use EtherNet/IP Configurator to import the Opto 22 SNAP PAC Learning
Center's ioCookies 1/0 configuration and then configure the SNAP-AICTD module in slot 3 of the
module configuration.

In order to configure the ioCookies I/0 module configuration in EtherNet/IP Configurator, you must
first use PAC Control to export the I/O configuration as an Opto Tag Database (.otg) file.

Creating an I/0 Configuration Export File
1. Toopen PAC Control:

— InWindows 7 and Windows Vista, press the Windows Start key &, and then click
Programs > Opto 22 > PAC Project 9.6 > PAC Control.

~ InWindows 10 and Windows 8.1, press the Windows Start key (€&
9.6 and then press the Enter key.

2. InPAC Control, open the PAC Control version of the ioCookies strategy.

,type PAC Control

The ioCookies strategy is usually located on your local hard drive at Program Files > Opto22 >
PAC Project > Control Basic Examples > ioCookies.

3. Create a new I/O unit for your SNAP PAC R-series controller and move all of the I/0 points from

the existing 1/0 unit (Mixed_IO_Unit) to the new 1/0 unit, as follows:

a. Choose Configure > 1/0 to open the Configure I/0 Units dialog box.

b. Select Mixed_IO_Unit, and then click the I/O Points button to open the Configure I/0
Points dialog box.

¢. Expand Module 00, highlight the point in slot 0, and then click the Move To button to open
the Move Point dialog box.

d. Select the new I/O unit, select the first available target channel, and then click OK.

e. Repeat this process for each point (highlighting the point and moving it to the new I/0
unit) until you have moved all of the I/O points to the new I/O unit.
f. Close all of the open dialog boxes in PAC Control.

4. Inthe strategy tree, right-click the old I/O unit and choose Delete to remove it.
5. Inthe strategy tree, right-click the I/O Units folder and choose Export from the pop-up menu.

The Export I/0 Units to an Opto Tag Database dialog box appears.
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6. Navigate to the location where you want to place the export file. Type the file name, and click
Save to create the export file.

Importing the Configuration File into EtherNet/IP

1. Inthe EtherNet/IP Configurator main window, click the Open button 1| or choose File >
Open to open the Open Tag Database dialog box.

Open Tag Database

File name: |Dpto_22_Config.otg
Files of type: |Dpto Tag Databaze Files [* atg) ﬂ LCancel

2. Llocate the I/O configuration (otg) file and click Open to import the file.
3. Double-click the device name to open the Modify Device Definition dialog box.

# ioCookies_I0_Configuration® - Etheret/IP Configurator |ZHE|E|
File Edt Tools Yiew Help
O0=H 7
i = Add new device... - -
DOU ble Clle— + Configure 1/0 Modules & Paints | Configure PID Loops I Configure Assemblies] Werify ]
devi(:e name Discovered Devices
Modules and Points | Type | Feature / Scali
# [ [00] SNAP-IDCED: 2.5 - 28VDC Drigital Input
+ - [01] SMAP-ODCESRC: 5 - BOVDLC Source  Digital Output
+ |ﬂ [02] SMAP-A0W-27 Ainalog Output
+ - [03] SMAP-AICTD Analog Input Madify
+ - [04] SMAP-al Analog Input
Expand All
Collapze Al
4 *
Feady UM

4. Enter the correct IP address for the PAC R controller.
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Modify Device Definition

Device Name: [SNAP_PAC_ID

Description: |

Device Type: |SN)1P—PAC—R2 j
10.183.57.100
2001

IP Address:

Enter the PACR's IP address

Part:

Temperature:  © Fahrenheit ™ Celsius

‘W atchdog: * Mo  Yes
()8 | Cancel |

This is important because the imported configuration will likely have the local loopback
address for the 1/0 unit (127.0.0.1) instead of the IP address for the PACR. In order to
communicate with the PACR, EtherNet/IP Configurator needs the device’s IP address.

Configuring the SNAP-AICTD Module Input Assembly

The input assembly’s role in this exercise is to read the temperature as a REAL (a 32-bit float).

1. In EtherNet/IP Configurator, open the ioCookies I/O configuration as described in the previous
section, then expand the configuration for the SNAP-AICTD module in slot 3.

2. Notice that point 0 of slot 3 connects to the process temperature probe.

#8 ioCookies_I0_Configuration - EtherNet/IP Configurator

9((=1E

File Edit Tools Wiew Help
O=H ?
= Add new device... - -
+- SNAP_PAC_IO Configure 1/0 Modules & Paints | Configure PID Loops] Canfigure Assemblies] Werify ]
Discovered Devices
Modules and Paints | Type | Featun =
+ |j [00] SMAPHDCED: 25 - 28%DC Digital Input |
+ - [01] SMAP-ODCRSRLC: 5 - BOWDC Source  Digital Dutput
[ (02 SNAP-ADY-27 Analog Output [
= - [03] SHAP-AICTD Analog Input Madify
I% 0 ailvenT emperature w_
+ gl (041 5NAP-AlY Analog Input Euand !
Collapse Al
1 v
Ready MM

3. (lick the Configure Assemblies tab, select assembly instance 100, and click the Add button to
open the Add Assembly Member dialog box.

4, Make the following selections:
— Class: Analog Input Point
— Instance Information: Module 3, Point 0
- Attribute: rValue
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Add Assembly Member

3

FID Loop Controller
Communication W atchdog
Pad

=]

Cancel

Description:
Class: Instance Information: Altribute:
Dizcrete Input Paint Walue
Dizcrete Dutput Point " Point Mame Minirmumry alue
I awimurnrty slue
Analog Dutput Point | =
Load Cell Input owS caledE ngineeringUnits
Scratchpad DINT HighS caledE ngineering nits
Scratchpad REAL : Offset
Scratchpad STRING . it | - | Gain
Pulze &nd TPO Generator e ’—_| AveragingFilterweight
Famp Controller Paint: o h

Click OK.

As shown below, the assembly instance 100 has a single value, the rValue of module 3, point 0.
This corresponds to the Process Temperature input, which is the first of two channels on the
SNAP-AICTD module.

# ioCookies_I0_Configuration - EtherNet/IP Configurator,

File Edit Tools Wiew Help

O=HE

?

= Add new device...
+ SHAP_PAC_ID
Discovered Devices

Azzembly Ingtance: 100

101|102 | 103 104 [ 105 | 106 | 107 | 108 | 103 | 110 [ 111 | 112 | 113 | 114 | 115

Configure 140 Modules & Points | Configure PID Loops  Configure Assemblies l\u"erify ]

Description:

Aszzembly Members:

# | DINT | Bit | Size | Class

Instance

Altribute

] ] ] 32

Analog Input Paint

ailvenTemperature ... Malue Add

i

MM
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Configuring the SNAP-AOV27 Module Output Assembly

1. Click the Configure I/O Modules & Points tab and expand the configuration for the
SNAP-AOV-27 module in slot 2.

#8 ioCookies_I0_Configuration* - EtherNet/IP Configurator,
File Edit Tools Wiew Help

O=H ?
= Add new device...
+- SNAP_PAC_IO Configure 1/0 Modules & Paints | Configure PID Loops] Configure Assemblies] Werify ]
Discovered Devices
Modules and Paints | Type | Feature / Scalir «
+ |j [00] SMAPHDCED: 25 - 28%DC Digital Input
+ - [01] SMAP-ODCRSRLC: 5 - BOWDC Source  Digital Dutput
S 05 (021 SNAPADY-27 Analog Output [
0 aolvenTemperatureContral k _

OM_, 1 aoConveyorSpeedContral

0.000-100.000

+ - [03] SMAP-AICTD Analog Input
Expand All
+ - [04] SMAP-AIY Analog Input
Collapse Al
| v
< E3
Ready MM

2. (lickthe Configure Assemblies tab, select assembly instance 101, and then click the Add
button.

3. Onthe Add Assembly Member dialog box, make the following selections:
— Class: Analog Output Point
- Instance Information: Module 2, Point 0
- Attribute: rValue

Add Assembly Member

X

Description:

Class: Instance Information: Altribute:
Dizcrete Input Paint Walue

Dizcrete Dutput Point " Point Mame Commw atchdogE nable
A |

nalog Input Paint Commi atchdogh alue
Analog Dutput Paint | J

Load Cell Input LowerS caledE ngineeringUnits
Scratchpad DINT

UpperS caledE ngineeringUnits
Scratchpad REAL : LowClamp
Scratchpad STRING 5 s | = HighClamp
Fulse And TPO Generator . ’—_|
Famp Controller Paint: o h
FID Loop Controller
Communication W atchdog
Pad

(] 8 | Cancel

4, (lick OK.
5. On the Fill Module dialog box, select No, and then click OK.
This rvalue will be a type REAL, just like the analog input.
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#8 ioCookies_I0_Configuration* - EtherNet/IP Configurator,
File Edit Tools Wew Help

O=H ?
= Add new device... - -
+- SNAP_PAC_IO Configure 1/0 Modules & Paints | Configure PID Loops — Configure Assemblies l\u"erify ]

Discovered Devices
Azzembly Instance: 101

102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 ) 117 [ 112 | 113 | 114 | 115

Description:

Aszzembly Members:

#t | DINT [ Bit | Size | Class Instance Attribute
1] 1] 1] 32 Analog Dutput P...  aoOvenTemperatureC...  ialue Add

Delete
Modify

MM

Downloading the Configuration to the SNAP PAC I/O Unit.

1. Choose Tools > Download Configuration to Opto 22 Device to open the Download
Configuration dialog box.

2. Ifthisis the first time you are downloading an EtherNet/IP configuration, click the Clear
Settings button to erase all prior configurations, reset the PACR to its factory default settings,
and restart the I/0 unit.

3. (lick the Download button to download the new configuration.

# Download Configuration to Opto 22 Device r$_<|

Mame | Description | Fart Address List | D ownload |
SMAP_PAC_I0 2001 1019254115
Clear Settings

Cloze

Timeout [meec]:

< | B 10000 << Details

Configuring Device: 10.192.54.115
12 paints successfully configured.
16 of 16 Assembly Instances successfully configured.
Configuration saved to flash

Device: 10.192.54.115 Complete

When the configuration has downloaded successfully to the device, you are ready to configure an
EtherNet/IP module using RSLogix.
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Configuring an EtherNet/IP Module

The instructions in this example exercise are primarily for a ControlLogix 1756-L61. However, you
can also use a CompactlLogix 1769-132E. Any differences for the 1769-L32E are included.

1.
2.

Create a new RSLogix project named “Explicit_Messaging.”

For ControllLogi, select the I/0 Configuration folder in the controller organizer, and manually

add an EtherNet/IP interface.

The interface is added to the I/O configuration folder.

3SLogix 5000 - Explicit_Messaging [1756-L61]

File Edit WYiew Search Logic Communications Tools Window Help

Bl=d| S| 5[5Ee] o]

= Elawl[E el ala]) [ser.

Offline J. T RUN
Mo Forces ». :: oK.

y BAT
Mo Edits =3 il
Redundancy L5

E | Path: I <nones

&

o Al s ololo]

ﬂ_

f | i | 2 I\ Favorites £ Add-On A Safety A Slarms £ Bit £ TimeriCi

[:l Controller Explicit_Messaging
0 (0 Tasks

(23 Mation Groups

23 add-on Instructions

ES 110 Configuration
- 1756 Backplane, 1756-410

------ E{I [0] 1756-L61 Explicit_Messaging

Ready

)

For a CompactlLogix 1769-L32E PLC, when you create a new project in RSLogix, an Ethernet

interface named “LocalENB"is automatically created at slot 1.

2SLogix 5000 - Explicit_Messaging [1769-1L32E]

File Edit WYiew Search Logic Communications Tools Window Help

Bl=d| S| 5[5Ee] o]

= Elawl[E el ala]) [ser.

Offline J. T RUN
Mo Forces ». FDK

BAT
No Edits =3 i

L

E | Path: I <nones

A Hetfe]| S]] or] o

]

i | 2 I\ Favorites £ Add-On A Safety A Slarms £ Bit £ TimeriCi

[:l Controller Explicit_Messaging
0 (0 Tasks

(23 Mation Groups

23 add-on Instructions

ES 110 Configuration
Em Backplane, CompactLogix System

(Create Examine On instruction
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In this example, there is a 1756-ENBT/A (Revision 3.9) in Slot 1 of the Logix chassis. You will
need this information to complete the next set of dialogs.

3. Toadd the 1756-ENBT/A, right-click the I/O Configuration folder and choose New Module. ..
from the popup menu to open the Select Module dialog box.
4, Expand the Communications group, select the 1756-ENBT/A adapter, and click OK.

M Select Module 3
SeleCt the Module Description Wendor
1 756_EN BT/ 15 EN2T 15 11 Mbps Ethernet Brdge, Twsted Par Meda Ilen Bradley ~
1756-ENBT/A 1756 104100 Mbps Ethernet Bridge, Twisted-Pair Media Allen-Bradley
A ada pter 1756-EMET/A 1756 Ethernet Communication Interface allen-Bradley
1756-EMNET/E 1756 Ethernet Communication Interface Allen-Eradley
1756-EWEEA 1756 10§100 Mbps Ethernet Bridge w/Enhanced Web Serv.. Allen-Bradley
1756-SYMNCH A Synchlink Interface Allen-Eradley
+- Controllers
+/- Digital
+- Drives
+I- Mation
+- Other
+- Specialty L
bt
< | o
Find. | AddFavoite |
By Category By Wendor Favorites ]
QK | Cancel | Help |

5. Inthe Select Major Revision dialog box that appears, select the major revision of the
1756-ENBT/A module, which is 3 for the module used in this example.

Select Major Revision

Select major revision for new 1756-EMET A4
module being created.

b ajor Revision: P v
0K | Cancel | Help |

6. Click OK to open the New Module dialog box.

New Module rz|
Type: 17EE-EMBT 44 1756 10100 Mbpz Ethernet Bridge, -
Twisted-Pair Media
endor: Allen-Bradley
Parent: Local

Address / Host Name
Mame: |

Description: + |P Address: R X i
" Host Mame:

Slat: 1 3:
Revizion: 3 - 1 3: Electronic Keying: | Compatible Keying -

Iv Open Module Properties 0K, | Cancel Help
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7. Enter or select the following:
— Name: ENBTA
— Description: The 1756 ENBT/A in slot 1
- Slot: 1
— Revision (minor): 9.
Recall that our EtherNet/IP module has a revision of 3.9. The 9 is the minor revision number.

The other parameters are not necessary, so leave the other fields blank. The completed dialog
box should look like this:

New Module [‘5__(|
Type: 1786-EMBT A4 1756 104100 Mbpz Ethernet Bridge, -
Twisted-Pair Media
Yendor: Allen-Bradley
Parent: Laocal
Neme: |ENBTA Address / Host Name
o v )
Desciption:  [The 1756 ENET /A in slot 1 IP ddfess: |
" Host Mame: |
Slat: 1 EI:
Bevision: 3 B 9 EIZ Electionic Keving: |Compatible Keying j

Iv Open Module Froperties 0K | Cancel Help

8. (lickOK.
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The RSLogix window should now look like this:

i RSLogix 5000 - Explicit_Messasing [1756-L61]*

File Edit WYiew Search Logic Communications Tools Window Help

Bl@|d| 2| &|B(@f o] = &nla| k- mel alall -] 8

Dffline f. ™ RUN M—EE Pan [nore =1 &
No Forces b, F SAKT 4}
Na Edits Q; 0 ﬂ | | ‘ | | | ‘ | ﬂ
Bl i I3 ST T
42 Controller Explicit_Messaging M Module Properties: Local:1 (1756-EMBT/A 3.9)

4130 Tasks
-2 Mation Groups
(23 add-0On Instructions
+-[07 Data Types
3 Trends
=45 10 Configuration
=3 1756 Backplane, 1756-410
ﬂﬂ [0] 1756-L61 Explict_Messaging
[ 11 1756-ENET ) ENBTA
& Ethernet

abied UELS w

General Connection ]HSNE[W'Um] Mudulelnful Puort Cunfiguraliun] Fort Diagnuslics] Eackplanel

Bequested Packet Interval (RPI): El ms

[ Inkibit Module

[ Major Fault On Cortroller If Connection Fails YWhile in Fun Mode

Module Fault

Description The 1756 EMNBT/L, in slot 1

Status Cfiline

hiodule Fault

< | ¥ Status. Offline Ok | Cancel Help
Ready

9. (lick OK again to close the Module Properties dialog box.

Creating a MESSAGE Object

In RSLogix, an explicit message is created using a MESSAGE tag.

1. InRSLogix 5000, open the controller organizer, right-click Controller Tags, and then choose
New Tag.

=5 Contraller best
E ControllerEgs
23 Controllersul Handlsr

23 Power-Up Handler
=53] Tasks

=58 MainTask

+ C& MainProgram

3 Unscheduled Programs
-5 Mation Groups

3 Ungrouped Axes

2. Inthe NewTag dialog box, enter or select the following:
— Name: Read Message
Description: My read message for an MSG instruction
Tag Type: Base
- Data Type: MESSAGE
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To select MESSAGE, click the Data Type button, J to open the Select Data Type dialog
box.

Naw Tag

Marme: IHEEELMESSEQE ak

[X)
Description: My read message for Cancel

an MSG instruction

Help

Tag Type # Baw
 Alias

" Produced || j ArEUmErs

" Consumed

Data Type: » .

Scope:

40 Explicit_Messaging Select Dala Type

Style: ] Data Types:

|MESSAGE

T
INTEGRATOR
LEAD_LAG

LEAD_LAG_SEC_ORDER Heln
MaRIMUM CAPTURE

HINIMUM_CePTURE
MOTION_GROUP
MOTION_INSTRUCTIOM
MOVING_AVERAGE

ke ETE R

i

|#

1~ Auray Dimensions

L]

The completed dialog box should look like this:

Mew Tag [Z
MHame: |F|ead_Message 0K,
Description: My read message for Cancel

an MSG instruction
Help

Tope: Base =

Aliaz For: |
Data Type: |MESSAGE
Scope: |ﬁ| Explicit_Mezzaging j

Shyle: | J

V¥ Open MESSAGE Configuration

3. Atthe bottom of the dialog box, select Open MESSAGE Configuration.
4. C(lick OK to close the New Tag dialog box and open the Message Configuration dialog box.
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Message Configuration - Read_Message

Canfiguration l Eommunication] Tag ]
Message Type:
Service = Source Element; -
T |Custom J
Source Length: 1 3: [Bytes]
Service .
Code: [Hex] Class: [Hex] Dt =
Instance: Attribute:; [Hex) e Tae.
) Enable O Enable Waiting 2 Start 2 Done Done Length: 0
2 Enor Code: Entended Error Code: [~ Timed Out &
Emar Path
Ermor Text:
ak | Cancel | Help

Select Get Attribute Single for the Service Type.

Message Configuration - Read_Message

Canfiguration* l Communication] Tag ]
Message Type: | CIP Generic j
?ervice OpenConnection j Source Element: -
ype: -
Device Reset ~ . =
S D avioe WHO s Source Length: ] EI' [Byptes]
Ee'rjgl.ce [Fet Attibute Single k
o OpenCaonnection 0
Inztance: | Parameter Read
Parameter Wiite et Ve
PLS Awiz Configuration bl
) Enable ) Enable Waiting 2 Start 2 Done Done Lenath; 0
2 Eror Code; Extended Eror Code: [ Timed Out &
Emar Path:
Emor Text:
ak. | Cancel Apply Help
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Notice that the Source Element and Source Length fields are now inactive.

Message Configuration - Read_Message

Configuraliﬂnxl Eommunication] Tag ]

Meszage Type: |CIF' Genenc j
%BI[J\QZCB |Get Attribute Single ﬂ
Service .
Code: e [Hex] Clasz: || Hex)  postivation =
Instance: Attribute: [Hex] e Tag.
2 Enable 3 Enable wWaiting i Shart 2 Done Dot Lengthe O
0 Enor Code: Extended Eror Code: [ Timed Out €
Emar Path:
Emar Text:
QK | Cancel | Apply | Help

6.
Class: 4 (Hex)

Populate the Class, Attribute, and Instance fields as follows:

To Read an assembly instance is a Class 4 (Hexadecimal) Assembly operation.

Attribute: 3 (Hex)
This is a set Attribute option.

Instance: 100

This is assembly instance 100 that you configured within the EtherNet/IP Configurator.
For more information on the Class and Attributes, see form 1770, Ethernet/IP for SNAP PAC

Protocol Guide.

So far, the Message Configuration dialog box should look like this:

Message Configuration - Read_Message

Canfiguration® l Eommunication] Tag ]
Message Type: | CIF Gereric j
%:Eg;ce |Eet Attribute Single ﬂ
Service .
Bt e [Hex] Clasz: |4 [Hex] Destination =
Instance: {1001 Abtribute:| 3 [Hex] e Tem,
2 Enable 3 Enable wWaiting i Shart 2 Done Dot Lengthe O
0 Enor Code: Extended Eror Code: [ Timed Out €
Emar Path:
Emar Text:
QK | Cancel Apply Help
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CHAPTER 5: SETTING UP EXPLICIT MESSAGING

7. Forthe Destination, click the New Tag button to open the New Tag dialog box.
8. (reate a variable with the following attributes:

— Name: ICTD_Temperature
— Data Type: REAL
- Scope: Explicit_Messaging
9. (lick OK to close the New Tag dialog box.

Hame: |IETD_Temperature k.

Description: Cancel
Help

Tope: [Base -]

Aliaz Far: |

Data Type: |HE#'-‘«|- B

Scope: m{l Explicit_Meszaging j

Style: [Float -l

-

10. In the Destination field, select the new controller-scoped tag. In a MESSAGE object, the Source
Element and Destination must be controller-scoped tags.

ICTD_Temperature EI ||

Mame Data Type |Description | '\
+| Fead_Message MESSAGE My read message ..
ICTO_Temperature ., REAL |

Mare: ICTD_Temperature
Data Tvpe: REAL

Descripkion: 3
Shaow: Shaw Al >3

The completed Configuration tab should like this:
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Message Configuration - Read_Message

Eonfiguration"l Communication] Tag ]
Message Type: | CIP Gereric j
Service ; i ]
T |Get Attribute Single J J
Service l_ . ,_
Code: E (Hex) Class: 4 (Hez) Destination ICTD_T emperature] Ij
Instance: 100 Attribute:| 3 [Hex] e Tae.
) Enable O Enable Waiting 2 Start 2 Done Done Length: 0
2 Enor Code: Entended Error Code: [~ Timed Out &
Emar Path
Ermor Text:
ak | Cancel Apply Help

11. Click the Communication tab.

Message Configuration - Read_Message

Configuration® Communicationl Tag ]
Eath: Browse...
cop € [ = 4
~ ,—:| ’—:
[~ Connected = s
) Enable ) Enable Waiting 2 Start 2 Done Done Lenath; 0
2 Eror Code; Extended Eror Code: [ Timed Out &
Emar Path:
Emor Text:
ak. | Cancel | Apply | Help |

12. For a ControlLogix controller (1756-L61 with a 1756-ENBT/A) implementation, enter the
communication path, ENBTA, 2, 000.000.000.000, where:

— ENBTA is the name of the EtherNet/IP communication module in slot 1 of our chassis.
— 2indicates this is an external message.
- 000.000.000.000 is the IP address of your PAC remote I/0 unit.

Leave the Connected checkbox unchecked.
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Message Configuration - Read_Message

Caonfiguration® Eommunication”] Tag l

Path: |[EMBTA, 2,10.129.45.46 Browse...
EMNBTA, 2, 10,129 45 45

{+ i 3

3 = =

™ Connected v e
) Enable O Enable Waiting 2 Start 2 Done Done Length: 0
2 Enor Code: Entended Error Code: [~ Timed Out &
Emar Path
Error Text:

ak | Cancel | Apply | Help |

For a CompactlLogix controller (1769-32E) with an embedded EtherNet/IP Communication
module, the path changes slightly. RSLogix automatically names the embedded EtherNet/IP
module “LocalENB.” All other values of the path are the same.

Message Configuration - Read_Message

Configuration® Eommunication”] Tag ]

Path: |LocalEME, 2,10.129.40.46 Browse. ..
cop [ = =
~ ,—:| ,_
[ Connected = s
2 Enable &) Enable Waiting 2 Start 2 Done Dote Length: 0
2 Enror Code: Extended Error Code: [ Timed Out &
Ermar Path:
Emar Text:
Ok, | Cancel | Apply | Help

13. Click OK to close the dialog box and save the module configuration.
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Adding the MSG Instruction

An MSG instruction is used to trigger an explicit message. It starts only when the input rung
condition transitions from off to on, which is different than most other ladder instructions. Once the
MSG is triggered, the message occurs asynchronously. You do not need to keep the rung condition
true to the MSG instruction on. This will cause more logic time to be consumed each time the ladder
runs.

& RSLogix 5000 - Explicit_Messaging [1756-L61] - [MainProgram - MainRoutine]
B Fie Edt View Search Logk Communications Tooks Window Help

S| 8| %|B5 -

| - g E el el

Oifline
Mo Forces

1. I RUN
».| oK

E— Pdh[<m

=15

T AT

No Edits & F 1o

4 Hlele] vl ofolo] 2]
_J ;u\s-mm Iy o oW s

= 5 Controller Expheit_Messaging &
3 controler Tags
(53 Controler Fauk Hander
(23 Power-Up Handler
= Tasks
= 55 MainTask
= C manProgram
[ Program Tags
MainRoutine
(3 Unscheduled Programs
= 1 Motion Groups
53 Ungrouped Ases
) Add-On Instructions
= 5 Data Types
Cif User-Defined
Ly Strings
L Add-On-Defined
# [ Predefined
3 i Module-Defined
3 Trends
= 1 1O Configuration
= 1756 Backplane, 1756-410
- 0 1171 1756 i1 Fnlicit M-;« ¥

A timer to control
the rate the

A timer to control
the rale the

A timer to control
the rate the

Read_llessage is
toggled.

Read_Message is
toggled

Iy read message for
a W56 nstruction
Wa

Read_Message is

toggled

Type - CP Generic

Message Contral [ GEEENTESTTY ]

Read_Timer ON
—CEN. ]
F—oNy—

[—CEND>——— Move
Source

[—(ER>—

fol e i<l |

jadd Branch

Dest Read_Timer ACC
LE

o

L & timer to controt
the rate the
-Read_Message s
toggled

Read_Timer DN

Flag to indicate a
read s DCCUMTING.
Read_in_Progress

L)

Rung 0of |

L

APP

In the example, a timer is used to control how often the MSG instruction is initiated. The timer
creates a regular interval to read or write to the remote I/0. If the PLC and I/O are connected by very
high bandwidth or reliable wide area networking, you can set the timer to a reasonable interval (e.q.
1 second). However, if the wide area networking is unreliable or fairly limited in bandwidth, set the
timer for longer intervals such as 1 minute. The longer timer allows the message to complete fully,
even if it ends in an error in response to a communication request.

The ladder must now inspect to see when the message operation is complete or has completed in
error. Check the Boolean attributes of either .DN or .ER to inspect whether the message is done or
ended in an error.
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& RSLogix 5000 - Explicit_Messaging [1756-L61]" - [MainProgram - MainRoutine*] a3
B Fle Edt View Search Logic Communications Tools Window Help - &%
8|S\ S &(®|5| <] = paa = e ale
Offline: 0. FRun H Path: | criones Llﬂ
No Forces . EOK - T
NoEdis 2luy R R L e BT R R R RS |
MM\FMu‘{mzwiﬁi!mmuzl
= 3 Controler Exphct_Messagng | || 11| afia | s]
[ controler Tags
(21 Controller Fauk Hander -~
| Power-Uip Handler
-85 Tacks i Flag to indicate & My read message for Flag to indicate a
2 £ ManTask read is occurring a MSG instruction read is occurming
= (3 Mairbrogram Read_in_Progress Read_Wessage DN Read_in_Progress
[ Program Tags 1 I I u
ManRoutine
- My read message for
- & - uu;l:::edwovm a M5G instruction
3 e Aas R!ud_Melﬁ.uqe ER
(53 Add-On Instructions ’
= 3 Data Types
G user-Defined
¥ L Strings
(i, Add-On-Defined (End)
+ L Predefined
Coy Module-Defined
(3 Trends
= £ 1j0 Configuration
= @ 1756 Backplane, 1756-A10
#0111 7544 A1 Furbeir Mace ™ -
< > = E
Lol f K |
fready Rung 0.of 1 APP |

Rung 1 in this example is incomplete. When the XIC for Read_Message.DN closes, the explicit data
read is available. If the Explicit Message fails, the XIC for Read_Message.ER will close. In either case,
the typical ladder implementation will add additional logic to handle both successful and
unsuccessful communications.

The EtherNet/IP port is responsible for managing the TCP/IP communications of the explicit
messaging. According to Rockwell documentation the default unconnected timeout for an explicit
message is 30 seconds. This value may be changed by modifying the “UnconnectedTimeout”
member of the MESSAGE object. This timeout should not be lower than five seconds on an
optimally functioning network. Once an explicit message is initiated, it cannot be stopped.

Here are both rungs of the ladder in a single screen view.
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7 RSLogix 5000 - Explicit_Messaging [1756-L61]* - [MainProgram - MainRoutine*]

B Fle Edt View Search logic Communications Tools Window Help
8|\ S &(®|8| | = sale e el alel
Offline: 0. FRuN — Path: | crones
Mo Feeces ». :::::‘
NoEdts 2 5o 4 Hl|e] |
= 18] <[y Fovormes ) Addon (e £ B R Teiorte &
= Controler Expkx_Messagng e e e g 5
[ controler Tags
1 Controller Fauk Handler -~
! (21 Power-Up Handler A timer to control A timer to control A timer to control
= = Tasks the rate the the rate the he rate the:
=& MainTask. Read_Message is Read_Message s My read message for Read_Message is
= [ MainProgram toggled toggled 8 MSG instruction toggled.
[} Program Tags TON Read_Timer DN MS MOV
i ManRoutine 0 ——{ Timer On Delay —ENC> I Type - CIP Generic __|END>—— Move f—,
(53 unscheduled Programs Timer  Read_Timer |—ON>— Message Control [NEEEENEIEEETN || —<on>— Source 0
= £ Motion Groups Preset 50000 + —cER>—
31 ungrouped Axes Accum 0 Dest Fiead_Timer.ACC
[0 Add-On Instructions LT
= 3 Data Types
(3, User-Defined
Cip Strings
= | A timer to control
:: :‘M-Orrbeh'td the rate the
= edefined Read_Message is Flag o indicate a
J;w"'wm read is occurring
">
5 1/0 Configuration Rm_‘l:ne( DN Read_n_Progress
= & 1756 Backplane, 1756-A10 = L
% (0] 1756061 Expleit_Massag
= 8 [1)1756-EN2T/A ENBTA
&5 Ethernet Flag to indicate a My read message for Flag to indicate &
read is occurming 8 MSG instruction read is occurring
Read_in_Progress Read_Message DN Read_in_Progress
1 : I +
My read message for
2 5 & MSG instruction
Read_Message ER
r\m T Loddw Dsgram(Man) A~ T
Descrigion | b -
: 2 [l S | 2
[Enter operand of type MESSAGE Rungoef 1 AP i

Configuring a MSG to Write an Assembly Instance

A write assembly instance is also triggered by a timer, the same as a read assembly instance. You
should not use the message’s .ER and .DN attributes to trigger the next message operation because
that can cause erratic operation.

For more detailed information on creating a MESSSAGE object, see “Creating a MESSAGE Object”on
page 43.
1. Inthe controller organizer, right-click Controller Tags, and choose New Tag.
2. Inthe New Tag dialog box, enter or select the following:
- Name: Write Message
- Description: My read message for an MSG instruction
- Tag Type: Base
— Data Type: MESSAGE
3. Atthe bottom of the dialog box, select Open MESSAGE Configuration.
4, (lick OK to close the New Tag dialog box and open the Message Configuration dialog box.
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Message Configuration - Write_Message

Canfiguration® l Communication] Tag ]
Message Type: | CIP Gereric j
Service i f = Source Element; Analog_Output -
T |Set Attribute Single J u

Source Length: 4 3: [Bytes]

Service .
Tor 10 [Hex] Classz: |4 [Hex] J
Instance: 110 Attripute:{ 3 [Hex) e T,

) Enable O Enable Waiting 2 Start 2 Done Done Length: 0

2 Enor Code: Entended Error Code: [~ Timed Out &

Emar Path

Ermor Text:

ak | Cancel | Apply | Help |

Note that this message is an Opto 22 Object Model Class 0x04, attribute Oxe, and references the
assembly instance 101, where the output is configured.

Populate the fields as follows:
- Service Type: Set Attribute Single
— Class: 4 (Hex).
To Read an assembly instance is a Class 4 (Hexadecimal) Assembly operation.
- Attribute: 3 (Hex)
This is a set Attribute option.

— Instance: 101

For more information on the Class and Attributes, see form 1770, Ethernet/IP for SNAP PAC
Protocol Guide.

Click on the Communication tab, and enter the same connection path as you did for the read
message.
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USING USER DATA TYPES (UDTS)

In order to make this an unconnected message, do not check the Connected box. Unconnected
messaging is the most efficient usage of TCP/IP encapsulation sessions in the Logix
architecture.

Message Configuration - Write_Message

Configuration®  Communication® ] Tag l
Path: [ENBTA, 2. 10,123 45 46 Browse...
EMNBTA, 2, 10.129.45.45
cop o =
c = =
[ Connected =3 e
2 Enable 3 Enable wWaiting 3 Shart 3 Done Dame Lengthe O
3 Enor Code: Extended Eror Code: [ Timed Out &
Emor Path:
Emor Text:
[1]4 | Cancel | Apply | Help

7. (lick OK to close the dialog box and save the module configuration.

Using User Data Types (UDTs)

If you are using version 16 or newer of RSLogix 5000, UDTs offer Explicit Messaging the ability to
access assembly instance data with system meaningful attributes. By giving an attribute to each
object within the UDT, it is much easier understand what an assembly instance is.

For example, compare these two data statements:
«  PACO.Data[2].3
«  PACTurn_Conveyor_Off

The second statement is easier to understand than the first one. UDTs also permit mixed data types
within a single object; you can place REALs, DINTs, INTs, and BOOLs throughout the UDT. These
values may be read or written at will, as a single block of data.

When implementing digital I/O states to map to the EtherNet/IP Configurator's assembly instances,
use the BOOL data type in the UDT definition.

Remember that RSLogix 5000 will collect continuous BOOL definitions in the UDT into rounded
32-bit data sizes. We recommend that you create a BOOL padding in the UDT, or else create a BOOL
array of 32 values to clearly indicate the extension of the BOOL data. This will avoid confusion to data
mismatches between the assembly instance and the MSG operation. To match this padding, the
assembly instance configuration must also have an appropriate pad to fill out a block of 32-bits.
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Summary

Explicit messaging is simply a manual method of acquiring I/0 data. In combination with the
EtherNet/IP configurator, you are still able to read and write I/0 values to configure or manipulate
/0 states.

Explicit messaging provides a way of accessing data upon demand, and it isn't necessarily difficult. It
requires a couple rungs of ladder to implement, a bit more effort than with implicit messaging.

The ladder controls when incoming and outgoing messaging occurs and the messaging occurs over
TCP/IP This is very useful for implementing very remote or expansive network monitoring and
control systems.

Explicit messaging is the only method for accessing SNAP PAC1/0 in Allen-Bradley PLC lines outside
of the Logix 5000 family such as the MicrolLogix 1100 and 1400 families, which do not support
implicit (I/O) messaging.
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6: Connecting PAC Controland
Allen-Bradley Systems

In this chapter you'll learn how to connect a SNAP PAC controller with an Allen-Bradley ControlLogix
programmable logic controller (PLC) so that you can use either implicit or explicit messaging to
exchange data between these two automation systems.

Connecting the two systems includes the following activities:

«  Modifying the PAC Control strategy.

»  Creating and downloading EtherNet/IP assembly instances.
+  Modifying the RSLogix ladder.

Each of these activities is demonstrated using a simple example.
In addition to the things listed on page 11 you will need:

«  PACProject Basic or PAC Project Professional. PAC Project Basic is free. Both versions are
available on the Opto 22 website, www.opto22.com.

o ASNAP PAC-S series or -R series controller, or a SNAP PAC EB-series brain.

In this Chapter

EXCNANGING VAIUES ..o ssssseessssisssenes 58
Modifying PAC Control. . . . . .
Creating Scratchpad Assemblies with EtherNet/IP Configurator........ 63

Modifying the RSLOGiX 5000 Ladder ....occcvvvveseeveessceeeessesseesssssssesssssssees 68
EXChaNGing Data ONliNE ..o sssssseesssssssenes 71
More Ideas for ACCESSING Dat@......ooouvvvceeeereeesssnsseesssssees e ssssseessssnssenes 71
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EXCHANGING VALUES

Exchanging Values

By doing the example exercises in this chapter, you will learn how to exchange several values
between an Opto 22 automation system and an Allen-Bradley PLC. Each system has a few variables
that need to be exchanged between each other. The example assumes that the control systems
already exist and the parameter sharing simply “marries”the two systems together.

Modifying PAC Control

Your PAC Control strategy needs to be modified slightly to allow data to be read from and written to
the Allen-Bradley PLC. For small data-sharing applications, the modifications will take only a few
minutes.

Adding an OptoMMP Device

The first thing to do is add an I/0 unit to your PAC Control strategy.
1. If PAC Control isn't open, start it as follows:

and then click

In Windows 7 and Windows Vista, press the Windows Start key (&)
Programs > Opto 22 > PAC Project 9.6 > PAC Control.

In Windows 10 and Windows 8.1, press the Windows Start key
9.6 and then press the Enter key.

S type PAC Control

2. Open your strategy in PAC Control.

4 PAC Control Basic - Cookies * - [Powerup] - O *
ﬂ’, File Edit Configure Chart Subroutine Compile Mode Tools View Window Help - 8 X
EIT I © | 2|
Cookies < B A
[ IC5) Cookies 3
) Control Engines This chart starts the program and all other charts.
IC5) Subroutines Induded =
& (5 Charts Start Program
= I£5) Variables
@ [C3) Mumeric Variables |
! String Variabl = 2 5
g s Wait until start flag is set
I Pointer Variables
true (non-zero).
[E5) Communication Hand F ( )
[E5) Mumeric Tables
[C5) String Tables T
[C5) Pointer Tables
£ 1/0 Units s Start the alarm monitoring
Start Charts dough/chip control, press
control, and oven/inspect
charts.
v
£ >
(i)Shortcuts | 100% v
< > A AT o] chart /
SNet Gprev|[g Povrp
PAC Control: Ready Configure NUM
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3. Double-click the I/0 Units folder to open the Configure 1/0 Units dialog box.

4 Configure /0 Units X
Name Type Port Address Watch. Add...
Modify...
Delete
10 Points...
=3 > PID Loops...
Close Help Event/Reactions...

4. C(lickthe Add button to open the Add I/0 Unit dialog box.

5.

Add or select the following information, depending on the type of OptoMMP device you're
using.

For S-series controllers:

— Name: Type a name for the device. In this exercise, our device is named “iol.ocal.”

- Type: Select “Generic OptoMMP Device.”

— IP Address: Check the box for “Local (loopback).”

For R-series controllers or EB-series brains:

- Name: Type a name for the device. In this exercise, our device is named “ioLocal.”
- Type: Select the part number for your SNAP PAC device.

— IP Address: Enter the IP address of your SNAP PAC device.

If you are using PAC Control Professional, leave the Secondary Address blank.

If you are using an S-series controller and PAC Control Basic, the completed dialog box should
look like this:

) Add 170 Unit x
Information
MName: | ioLocal |
Description: | |
Type
Type: | Generic OptoMMP Device At |
Addressing

IP Address:

Ethernet Port: 2001

Communication from control

Enable communications from control engine

Timeout and disable communications after tries of second(s) each.

Cancel Help

Now, you're ready to modify the chart as described in the next section.
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Modifying the Chart

In this section you will learn how to modify a strategy to exchange data. In the example, you will
create a new chart, but you can modify an existing chart the same way. The new chart will read and
write shared values to and from the scratchpad registers in the local I/0 unit.

The PAC Controller has 32-bit integer, 32-bit float, and string registers. 32-bit integers are

synonymous to the DINT data type. Opto 22 32-bit float data type is the same as the Logix REAL.

1. Before adding some code to the PAC Control strategy, create a couple of tables similar to the
ones below to show which scratchpad registers will hold what particular values.

32-bit Integer Scratchpads

Index Variable

0 i32PACBuffer_Tank_Ready
1 i32PACTank_Contents

2 dABFill_Tank

3 dABBottles_Filled

32-bit Float Scratchpads

Index Variable
0 f32PACGallons_In_Tank
1 rABGallons_Requested

2. Using either an OptoScript block or an action block, create code to write PAC Control values to
the scratchpad. When the data is present on the scratchpad, it is available to be read by other
applications such as the Logix PLC.

Using an OptoScript block:

OptoScript Code:

< =zt the integer =cratchpad walue for reading by the A-BE FLC
SetlolnitScratchPadInti2Element {iclocal . 0, 132PACBuffer Tank_Ready):
SetIollnitScratchPadInt32Elenent (iolocal .1, 132PACTank_Contents)

< zet the float scratchpad waluse for reading by the A-BE FLC
SetlolnitScratchPadFloatElenent {iclocal . 0, {32PACGallons_ In Tank):
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Using an action block to achieve the same thing:

howve 32-hit Integers to Scratchpads
Comment (Single Line)

Set 1/0 Unit Scratch Pad Integer 32 Element

10 Unit ioLocal

Index 0

From 132PACBuffer_Tank_Ready
Put Status in dABBottles_Filled

Set 1/0 Unit Scratch Pad Integer 32 Element

10 Unit ioLocal

Index 1

From 132PACTank_Contents
Put Status in dABBottles_Filled

lowve Float to Scratchpads
Comment (Single Line)

Set /0 Unit Scratch Pad Float Element

10 Unit ioLocal

Index 0

From f32PACGallons_In_Tank
Put Status in dABBottles_Filled

3. Once again using either an OptoScript block or an action block, this time create code that reads
the values the Allen-Bradley PLC writes to the scratchpads of the SNAP PAC controller.

The PAC Control environment reads the values emplaced by the A-B PLC and moves them into
similarly named variables.

Using an OptoScript block:

OptaScript Code:

< get the integer scratchpad walue emplaced by the A-B PLC
GetIolnitScratchPadInt 32ZElement (ioLlocal . 2 dABFill_ Tanlk:
GetIolUnitScratchPadInt32Element{iolocal . 3, dABBottles _Filled)

<« get the float scratchpad value emplaced by the A-B PLC
GetIolnitScratchPadFloatElement (ioLlocal .1, rABGallon=s Requested)

< .
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Using an action block sequence of commands to retrieve the A-B PLC scratchpad values:

# Instructions - Data_Sharing - Read Scratchpads

Get 32-bit Integers from Scratchpads Add...
Comment (Single Line)

Get 1/0 Unit Scratch Pad Integer 32 Element

10 Unit ioLocal

Index 2

Put Result in dABFill_Tank

Put Status in dABBottles_Filled

Get 1/0 Unit Scratch Pad Integer 32 Element

10 Unit ioLocal

Index 3

Put Result in dABBottles_Filled
Put Status in dABBottles_Filled

Get Flosts from Flost Scratchpads
Comment (Single Line)

Get 1/0 Unit Scratch Pad Float Element

10 Unit ioLocal

Index 1

Put Result in rABGallons_Requested
Put Status in dABBottles_Filled

[ Cloze ] [ Help ]

See the next section for more scratchpad read and right commands.

Scratchpad Read and Write Commands
Here is a complete list of the PAC Control scratchpad read and write commands.
Scratchpad Read Commands:

»  Getl/O Unit Scratch Pad Float Element

«  Getl/O Unit Scratch Pad Float Table

«  Getl/O Unit Scratch Pad Integer 32 Element

«  Getl/O Unit Scratch Pad Integer 32 Table

»  Get1/O Unit Scratch Pad String Element

»  Getl/O Unit Scratch Pad String Table
Scratchpad Write Commands:

«  Setl/O Unit Scratch Pad Float Element

«  Setl/O Unit Scratch Pad Float Table

«  Setl/O Unit Scratch Pad Integer 32 Element

+  Setl/O Unit Scratch Pad Integer 32 Table

»  Setl/O Unit Scratch Pad String Element

»  Setl/O Unit Scratch Pad String Table
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Creating Scratchpad Assemblies with EtherNet/IP Configurator

For this section you will need to use EtherNet/IP Configurator to create assemblies to exchange
between the PAC controller and the Allen-Bradley PLC.

Creating an Assembly to Send Data to the PLC

1. [If EtherNet/IP Configurator isn't open, start it as follows:

- InWindows 7 and Windows Vista, press the Windows Start key [&), and then click
Programs > Opto 22 > PAC Project 9.6 > EtherNet-IP > EtherNet-IP Configurator.

—  InWindows 10 and Windows 8.1, press the Windows Start key (&)
Configurator 9.6 and then press the Enter key.

, type EtherNet-IP

Starting EtherNet/IP Configurator immediately creates a new configuration.

# Untitled - EtherNet/IP Configurator,

File Edit Tools Wiew Help
O=H ?
= Add new device... - -
B innamed_Device Configure 1/0 Modules & Paints | Configure PID Loops] Canfigure Assemblies] Werify ]
Discovered Devices
Modules and Paints | Type | Feature / ¢ &
Add...
Expand All
Collapse Al
1 v
Ready MM

2. Double-click the Unnamed_Device in the device tree to open the Modify Device Definition
dialog box.

3. Select the Device Type that matches your controller.
4. Enterthe IP address of the SNAP PAC controller in the IP Address field.

The example uses a SNAP-PAC-S2 with the IP address of 10.154.92.57, but you can use any
R-series or S-series controller, or EB-series brain.
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Modify Device Definition

Device Name: [SNAP_PAC_52

Description: |The PAL Controller

Device Type: |smp—mc—s 1/52
|P tddress:  |10.154.9257
2001

=

Part:

Temperature:

‘watchdog: =

=]

Cancel |

5. (lick OK to close the dialog box, then click the Configure Assemblies tab.

6.

The tab opens assembly instance 100, whic
data to the Allen-Bradley PLC.

# Untitled* - EtherNet/IP Configurator

File Edit Tools Wiew Help

O=HE ?

h you will use to send the appropriate scratchpad

= Add new device...
+ SHAP_PAC_52

Discovered Devices
Aszzembly Ingtance: 100

Configure 140 Modules & Points | Configure PID Loops  Configure Assemblies l\u"erify ]

[ 00| 1

Drescription:

102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 170 | 111

12113114 | 115

Aszzembly Members:

#t | DINT [ Bit | Size | Class

Instance |

Add

i

Ready

MM

Begin populating assembly instance 100 by clicking the Add button to open the Add Assembly

Member dialog box.

Add Assembly Member

Drescription:

3

Instance Information:

te |nput Paint
Dizcrete Dutput Point
Analog Input Paint
Analog Dutput Point
Load Cell Input
Scratchpad DINT
Scratchpad REAL
Scratchpad STRING
Fulse And TPO Generator
Famp Controller
FID Loop Controller
Communication W atchdog
Pad

=]

" Paint Mame

= Madule: |0 -
a -

Pairt:

Cancel

Altribute:

FeatureSelect
FeatureEnable
Featurelfalue
ClearFeaturelfalue
OnLatch

OffLatch
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7. Select the following items:

- Class: ScratchpadDINT (Notice that the available fields change.)

— Instance Information
Start Element; O
# of Elements: 1

— Attribute: Value

- Description: Add a comment such as “Location for i32PACBuffer_Tank Ready”to indicate
which value this scratchpad location will transfer. The example is the scratchpad element
for the PAC Control variable i32PACBuffer_Tank Ready.

Add Assembly Member [g|

Description:
|Location far i32PACBulfer_Tank_Readw

Class: Instance Information: Attribute:
Dizcrete Input Point

Dizcrete Output Point Start Element: |0

Analog Input Point

Analog Output Point # of Elements: 1

Load Cell Input )

Scratchpad REAL
Scratchpad STRIMG
Pulze And TPO Generator
Ramp Controller

PID Loop Contraller
Communication ' atchdog
Pad

QK. | Cancel |

8. Inthe same manner, add ScratchpadDINT element #2 for “i32PACGallons_In_Tank.”

Add Assembly Member [g|

Description;
|Locati0n for iZ2PaCGalons_In_Tank

Class: Instance |nformation: Athribube:
Dizcrete [nput Paint
Dizcrete Output Point Start Element: |0

Analog [nput Poirt
Analag Output Paint Hof I w
Laad Cell InEut aof Elements:

Scratchpad REAL
Scratchpad STRING
Pulze And TPO Generatar
Framp Controller

PID Loop Contraller
Communication \Watchdag
Pad

(]9 | Cancel |

9. Toadd the float variable, click again and select the following items in the Add Assembly
Member dialog box:

— Class: ScratchpadREAL
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— Start Element: 0
— Description: Location for f32PACGallons_In_Tank

Add Assembly Member

%]

Description;
|Location for f32PACGllons_In_Tank

Class: Instance |nformation: Attribute:

Discrete Input Point Vale |
Digcrete Output Point Start Elerment: |0

Analog Input Point

Analog Output Point # of Elements: [1

Load Cell Input )

Scratchpad DINT

Scratchpad STRING
Pulze And TPO Generator
Famp Controller

PID Loop Controller
Communication 'Watchdog
Pad

ok, | Cancel

10. Click OK.

Your completed assembly instance 100 should look similar to this:

# Untitled* - EtherNet/IP Configurator

File Edit Tools Wiew Help

O=H ?
= Add new device... - -
+- SMAP_PAC_S52 Configure 1/0 Modules & Paints | Configure PID Loops — Configure Assemblies l\u"erify ]

Discovered Devices
Aszzembly Ingtance: 100

101 | 102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 [ 111 | 112 | 113 | 114 | 115
Drescription:

|Data from PAC Control to the A-B PLC
Aszzembly Members:

# | DINT | Bit | Size | Class Instance | Attribute | Description
1] 1] 1] 32 Scratchpad DINT  Element: 0 Value Location for i32PACBuffer_Tank_Ready Add
1 1 1] 32 Scratchpad DINT  Element: 1 Walue Location for i32PACG allons_In_Tank

2 2 0 32 Scratchpad REAL  Element: 0 Walue Location for f32PACG allons_|n_Tank Delete

Modify

|

Ready

Creating an Assembly to Accept Data from the PLC

This section describes how to create assembly instance 101, which will be used to accept data from
the Allen-Bradley PLC. This is similar to creating assembly instance 100.

1. Follow the directions in the previous section for creating assembly instance 100, except note

the minor differences for the Element values.
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When completed, assembly 101 should look similar to this:

# Untitled* - EtherNet/IP Configurator ._||'E|rz|
File Edit Tools ‘Wew Help
L=E %
= Add new device... - -
+- SMAP_PAC_ 52 Canfigure 1/0 Modulas & Points] Configure PID Loops  Configure Assemblies ]Verif}' ]

Discovered Devices
Aszsembly Instance: 101

102|103 | 104 (105 | 106 | 107 | 108 | 103 | 110 | 117 | 112 | 113 | 114 [ 115

D escription:

|Data from A-B PLEC to PAC Corntrl
Agzembly bMembers:

# | DINT | Bit | Size | Class Instance Attribute
1] 0 0 32 Scratchpad DIMNT - Element: 2 Walue Add
1 1 0 32 Scratchpad DIMNT - Element: 3 Walue
2 2 0 32 Scratchpad REAL  Element: 1 Walue Delete
todify
JReady M

To download the configuration to the PAC controller, choose Tools > Download Configuration
to Opto 22 Device.

The following dialog box appears.

# Download Configuration to Opto 22 Device [‘5_<|

Mame Description Fart Address List D ownload |
e b 10.154.92.57
Clear Settings

Cloze

Timeout [meec]:

| B 10000

|

Click the Download button.

The following status information should appear showing that the configuration has been
successfully saved to flash.
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# Download Configuration to Opto 22 Device

Mame | Description | Fart Address List | D ownload |

SMNAP_PAC 52 The PAC Controller 2001 10.154.92.57
Clear Settings

Cloze

Timeout [mzec]:

< > 10000 << Details

Configuring Device: 10.154.92.57
16 of 16 Assembly Instances successfully configured.

Configuration saved to flash
Device: 10.154.92.57 Complete

4. Ifyouhaven't already done so, choose File > Save As to give your configuration project a name
and to save it for later use.

Once you have created assemblies 100 and 101 using EtherNet/IP Configurator, the next step is to
use RSLogix 5000 to add some code to exchange data with the Assembly Instances you just created.

Modifying the RSLogix 5000 Ladder

In this section you will do the final step of integrating the two systems together by adding
functionality to the PLC's ladder. The instructions are for a ControlLogix PLC (1756-L61).

In previous sections you modified the scratchpad read and write values in the PAC Control strategy,
and you used EtherNet/IP Configurator to configure the PAC Controller to expose the scratchpads
with Assembly Instances 100 and 101.

In the following exercise you will add the interface to RSLogix 5000.

1. Adda Generic Ethernet Module to the Logix PLC's EtherNet/IP module using the following
settings.

— Name: PAC

— Comm Format: Data - DINT

— IP Address: Use the address of your PAC Controller
- Connection Parameters

Assembly

Instance  Size
Input 100 3
Output 101 3
Configuration | 254 0

The Input and Output Assembly Instance information is based on the Assembly Instances
created in the EtherNet/IP Configurator software.
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Leave the Configuration Assembly Instance to 254 and the size to 0 because the
configuration assembly is not used. These settings tell RSLogix 5000 to ignore it.

New Module

Type:
Wendor: Allen-Bradley
Farent: EIF

I arne; |p,a_[:

Dezcription: ‘

Comrmn Format: |Data -DINT ﬂ
Address / Host Name
(* |PAddress: | M 0123 0 46 .M

™ Host Name: |

[V Open Module Properties

ETHERMET-MODLLE Generic Ethemeat Module

Connection Farameters

Input;

Output:

Configuration; |254

]

X]

Azzembly .
Instance: Size:

100 ERE
R R -2
0 =] @b
T
—

Cancel | Help

2. (lick OK to open the Module Properties dialog box.

3. (lick on the Connection tab and set the RPI to 500 milliseconds for demonstrating the data

exchange.

M Module Properties: EIP (ETHERMET-MODULE 1.1)

General  Connection” l Module Info]

Requested Packet Interval [RPI): 500.03: ms  [1.0- 3200.0 ms]
[ Inhibit Module

[~ Major Fault On Contraller IF Connection Fails While in Bun Mode

Module Fault

Cancel

=]

Statuz: Offline

| Apply

| Help |

4. You're almost done. Now you just need to add a few CPS commands to copy the Generic
Ethernet Module's data to and from local variables of the ladder.
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Here's a screen shot of the complete CPS instructions in the ladder.

o RSLogix 5000 - Bottling [1756-L61]* - [MainProgram - MainRoutine]

B Fle Edit ¥iew Search Llogic Communications Tooks Window Help -8 %
Bl@ M| & &[E]@] <] o o &g B M 2le
Dffline 1, T RUN WS B Foin [ABLETHIP1MO192 5476 Backplane 0 1 &
Mo Forces b, ||: g;_[
WS B p A B el [ o] o] 2
|| [ e e T
] Tasks A ‘ | | | |
= £& MainTask
= l:} MainProgram Move Valugs from the PAC] Module Aray to PLC Variables A
[ Program Tags From the PAC
MainRautine PAC Contral Yariable Controller
0 I 0
(3 Unscheduled Programs e E“PS i . L'PES i e “PES N
Mation G 0 ynchronous Copy File L1 Synchionous Copy File wnchranous Copy File —
a m” ‘5“ ’°“"sd . Souce PAC: Datal0] Souce  PACHDatall] Saurce PAC: . Datal2]
ngrouped Axes Dest i32PACBulfer_Tark_Ready Dest i32PACT ank_Cantents Dest F32PACGalons_In_Tark
[ Add-On Instructions Length 1 Length 1 Length 1
£ Data Types
Eﬂ User-Defined
o E& Strings Move Yalues from PLC Variables to the PAC:0 Array
Eﬂ Add-On-Defined oPs CPs ors
Predefined
: % Ivlr:djel-n[?eﬁned 1 Synchronous Copy L1 Synchionous Copy File L1 Synchronous Copy File [—
& Source dABFill_Tank Source dbBBottes_Filed Source (8BGalons_Requested
Trends Dest  PAC:0.Datal0] Dest PAC:0.Data[1] Dest PAC.0Data[2)
5 10 Canfiguration Length 1 Length 1 Length 1
= B3 1756 Backplane, 1756-417
f [0] 1756-L1 Bottling
=1 ] [1] 1756-EMET/E EIP
+ 25 Ethernet v 3
- — ey |
4 r
Activate the Routine: MainPragram - MainRoutine(Ladder Diagram) Rung?? of 77 APP VER

Now the ladder is ready to be downloaded.
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Exchanging Data Online

When online, RSLogix will populate value fields something like this:

Logix 5000 - Bottling [1756-L61] - [Controller. Tags - Bottling(controller)]

File Edit WYiew Search Logic Communications Tools Window Help - | &8 x
B|=(a| S| »[%[8] of] = &a5 [ vE alal
Rem Run 0. I RUN [ Path: [AB_ETHIP-1%10.176.52 5448 ackplane\ & kS
Mo Forces . :: 0K @
- BAT
NoEdis Ef=ps K1 R =i = RS 73 R4 EOARCR A
i1 | T I3 ST ST S §
=3 Controller Bottling ~ Scope: | {0 Batting ~| _ Show. | messace
(el e Name & | Value €| Force Mask «| sSiyle Data Type +
3 Controller Fault Handler T 5
(3 Power-Lp Handier |+-dABBottles_Filled 324003 Decimal |DINT
65 Tasks ] BFTark 1 |Decimal DINT
-8 MainTask [32PACGAllons_In_Tank 12536.0 Flost REAL
+-C8 MainProgram | H32PACBuffer_T ank_Fleady 1] Decimal DINT
(33 Unscheduled Programs FH-i32PACT ank_Contents 14| | Decimal DINT
z agtm” arops [ [E-PACC : t.-a ] |AB.ETHEF
Ungrouped fxes | ABGalons_ Requestsd 150000.0] Float REAL
23 add-on Instructions -
-5 Data Types
L User-Defined
+ Cﬂ, Strings
L add-On-Defined
+- L Predefined
+- g Module-Defined
23 Trends
=423 1f0 Configuration v L]
< > ¥
= — < [» [\ Manitor Tags ) Edit Tags / ] [ [
Ready

As shown here, you can create a watch window in PAC Control to see the exchanged values.

A PAC Control Basic - [watch]

CBX

&d" File Edit Control Engine Debug  Chart  Subroutine Mode Tools  Wiew Wakch  ‘Window  Help Lo I
=} Debug & ] U]
kie M| | mame Type IVAL
® I Control Engines ~ dABBottles Filled Integer 32 Variable 324003
[ Subroutines Include dABFill Tank Integer 32 Variable o
= ) Charts f32PACGalloms In... |[Float Variabie 12536
T Data_Sharing i32PACBuffer Tan... Integer 32 Variable 1
] ?Qpawerup 132PACTank Contents Integer 32 Variable 14
= ) Variables _— rABGallons Reque... Float Variable 150000
= I Numeric Variab
2] dABBottles_
I% dABFill_Tan
34 £32PACGall
(8] i32PACBuff
&l 32PACTani
12 i7Prw Nie ¥
= — () | >
TR || — )
IPAC Control: Ready INFO MM
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More Ideas for Accessing Data

Once the data is exposed into the PAC Controller's scratchpads, the following methods are available
to access it.

OptoOPCServer

The Opto 22 OptoOPCServer is a high-performance, multithreaded OPC DA 2.0 complaint data
server. Using SCADAs and OPC Clients to access data, the scratchpad registers created in the
example exercise are accessible using the OptoOPCServer. The following table translates which
variables belong to the appropriate tags:

Shared Variable OPC Item ID

i32PACBuffer_Tank_Ready | [mmiolip|tcp:10.192.54.75:2001]sp_integer[0]
i32PACTank_Contents [mmiolip|tcp:10.192.54.75:2001]sp_integer[1]
dABFill_Tank [mmiolip|tcp:10.192.54.75:2001]sp_integer[2]
dABBottles_Filled [mmiolip|tcp:10.192.54.75:2001]sp_integer[3]
f32PACGallons_In_Tank [mmiolip|tcp:10.192.54.75:2001]sp_float[0]
rABGallons_Requested [mmiolip|tcp:10.192.54.75:2001]sp_float[1]
PAC Display

Once the data is available in the scratchpads, they may also be displayed in PAC Display, Opto 22's
HMI package. To access the scratchpads of the PAC controller, download and install both PAC Display
Basic and PAC Control Basic, both free software packages available on the Opto 22 website,
www.Opto22.com.

Using PAC Control Basic, doing the following:
1. Create a new strategy (File > New Strategy).
2. Right-click the I/O units folder and choose Add to open the Add I/0 Unit dialog box.
3. Provide a name, and select the Type as follows:
—  For a SNAP-PAC-S series controller, select the Generic OptoMMP Device.
—  Fora SNAP-PAC-R1 or SNAP-PAC-EBT, select SNAP-PAC-R1.
—  Fora SNAP-PAC-R2 or SNAP-PAC-EB2, select SNAP-PAC-R2.
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X

#1 Add 1/0 Unit

Information

Mame: |M_I,I_Strateg_l,l |

Description: | |

Type

Tupe: | Generic DptoMMP Device v |

Addreszing

IP Acdress: [z 0 o 1] M
Ethermet Fort: 20M

Communication from control engine

Enable communications from caontral engine

Timeout and dizable communications after tries of zecond(z] each.

[ Ok, H Cancel ” Help ]

4. Saveand close your strategy.
Use your new strategy as the tag database into PAC Display.

Using the Free Opto MMP Toolkit

If you wish to use a custom PC application to access the data, use the OptoMMP Communication
Toolkit to access the scratchpad registers. The free kit is available on the Opto 22 website,
www.Opto22.com. Search for part number IOP-DEV-OPTOMMP.
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7: Using EtherNet/IP
Configurator

This chapter expands on the information in the previous chapters about EtherNet/IP Configurator
and includes additional topics not covered there.

In this Chapter

Importing an Existing Configuration ..........o.eeeecereee 76
Uploading a Configuration from an Opto 22 Device........77
Adding a Device Manually ..... . . B 78
Modifying a Device........ . . e 80
Changing a Device's IP ADAress......vveevccvveessssreesssssrensns 80
Adding and Deleting Assembly Elements............ccovveren. 81
Moving Assembly MemDETrs.......eeeeeeresieeessireersse 84
Viewing a Configuration Report .........eeeeersccveerssse 85
Configuring PID Loops. . . . e 86
Inspecting and TuNIiNg PID LOOPS .....vvvvvvvvvvesrsvrerssssssessne 92
USIiNG 1/0 POINT FEATUIES ..vvvvvrveveresieeeressseersesssesesssssnessness 104
Referencing I/0 Points on SNAP PAC Racks ... 106
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Importing an Existing Configuration

If you have an 1/0 configuration created in EtherNet/IP Configurator, you can import its otg (Opto
Tag Database) file and from it create a new configuration.

NOTE: You can also use an otgq file created in Opto 22's PAC Control or PAC Manager. For more information,
see the user's quides for those products, form 1700 (for PAC Control) and form 1704 (for PAC Manager).

1.

2.

In the EtherNet/IP Configurator main window, click the Open button [/ or choose File >
Open to open the Tag Database dialog box.

Open Tag Database

File name: |Dpto_22_Eonfig.otg

j Cancel

Files of type: |Dpto Tag Databaze Files [*.otg)

Locate the configuration (otg) file and click Open.

*1, EtherNet/IP Configurator, - Opto_22_Config*

File Edit Tools Wew Help
Oz E ?
= Add new device... -
_PAC_| Configure [0 Modules & Points | Canfigure PID Loupsl Conlfigure Assemblles] Werify I
+- SNAP_PAC_R2
*: SN’QP—P’QC—Sl_ Modules and Paints | Type | Features # Subty. | Units | We
Discovered Devices = [ [00]SNAPADCED: 25 - 28D Digital Input
+ - [01] SMAP-DDCESAC: 5 - 60 YDC Source  Digital Output
+ |ﬂ [02] SMAP-A0N-27 Analog Output
+ . [03] SHAP-AICTD Analog Input Madify
£ . [04] SMAP-AN Analog Input
Expand &l
Collapse Al
1 3
Ready MUM
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Uploading a Configuration from an Opto 22 Device

If there is an existing configuration that you want to use loaded on an Opto 22 device, you can
upload it to EtherNet/IP Configurator, and then modify it (if necessary) and reuse it on another
device.

NOTE: When uploading EtherNet/IP configurations from PAC devices, the following information is not
stored on the I/O unit and thus is lost during the upload.

PID names

PID descriptions

Point descriptions

4-channel digital module types

Assembly Instance descriptions

To upload a configuration:
1. Inthe device tree, select the Opto 22 device with the configuration you want to load.

‘1. EtherNet/IP. Configurator - Opt

_| File Edt Tools vYiew Help
D= E 7

-I- ddd new device...

¥

Selectan | SNAP_PACK

Opto 22 device - SMAP_PAC_51
-I- Discovered Devices
00-A0-30-00-90-F5

2. Choose Tools > Upload Configuration from Opto 22 Device.
The following dialog box appears.

EtherNet/IP Configurator

P | I/ Point and Assembly configuration data will be imported from device SMAP_PAC_RZ.
\'C() This operation will overwrite existing configuration data. Are wou sure that wou want bo proceed?

3. (lick Yes to upload the configuration data. This action overwrites the device's existing
configuration data for any module position that is the same as the new configuration data.
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Downloading a Configuration
1. To save the configuration, choose File > Save As, browse to an appropriate directory, name the
file (for example, Opto_lO), and then click Save.

2. (lickthe Verify tab and then click the Download button. (Or you can choose Tools > Download
Configuration to Opto 22 Device.)

3. Inthe Download Configuration dialog box, select the device's IP address, and then click

Download.
Download Configuration to Opto 22 Device
M arme | Description | Part Address List Daownload |
Opto_22_IRIO 2001 S
ear Settings
Close
Timeaout [msec):
< | B 10000

4. When the configuration has downloaded successfully, click Close.

Adding a Device Manually

In addition to being able to add a discovered device, you can also add a device manually. To add a
discovered device, see “Adding an Opto 22 Device”on page 12.

1. Inthe device tree, double-click Add new device.

Untitled - EtherNetfIP Configu
Flle Edit Tools Wiew Help

(= =] ?
BEAdd new device.k

+- Unnamed_Devick

Discovered Devices
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In the New Device Definition dialog box, at minimum enter the Device Name, select the Device
Type, and enter the IP address for the device.

New Device Definition

Device Mame: |Dpto_22_| 0B

Diescription: |

Device Type: |SNAP-PAC-EBZ -]
IP Addess:  [10.172.44.115

Port: 200

Temperature:  ©« Fahrenheit © Celsiug

W atchdog: * No  Yes

(1]4 | Cancel |

Device Name. Enter a name for the remote I/0. The name must start with a letter and may
contain letters, numbers, and underscores. (Spaces are converted to underscores.)

Device Type. Choose the part number of the Opto 22 device from the drop-down list.
IP Address. Enter the IP address of the device.

NOTE: Changing the IP address in this dialog box does not change the IP address on the device. If you
want to change the IP address on the device, see “Changing a Device’s IP Address” on page 80.

Port. The default Ethernet port number is 2001 for communication with the Opto 22 device. If
you have changed this port for security purposes, also change it here. (See the device's user
guide for details.)

Temperature. Choose whether temperatures will be handled in Fahrenheit or Celsius.

Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled). If
you select Yes, a new field appears; enter the Watchdog timeout value (in seconds). The default
timeout is 0.5 seconds.

NOTE: If you want to enable Watchdog on a point, make sure to enable it here at the device level as
well.

Click OK.
The new device appears in the device tree.

Fr System IV* - EtherMet/IP Config

File Edit Tools View Help
DeEE %
- Add new device...

+- Unnamed_Device

EaR SMAFP_IRIC

Discovered Devices

New device —
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Modifying a Device

Do the following steps to change a device’s information.

1.
2.

3.

In the device tree, double-click the device to open the Modify Device Information dialog box.
See “Adding an Opto 22 Device”on page 12 for tips on how to use this dialog box.

Modify Device Definition

Device Mame: (I

Description: |

Device Type: | SNAP-PAC-EBZ -
IP &ddress: |'| 0.0.0.2

Fort: 20

Temperature:  ©* Fahrenheit © Celsiug

W atchdog: * No  Yes

o]

Cancel |

NOTE: Changing the IP address in this dialog box does not change the IP address on the device. If you
want to change the IP address on the device, see “Changing a Device’s IP Address” (below).

Click OK to confirm the changes.

Changing a Device’s IP Address

1.

2.

Right-click the device in the device tree and choose Change IP Settings to open the Change IP
Settings dialog box.

Change IP Settings for 10.192.54.115 fz|

|P Address: m .o . 0.0

Subnet b ask: | 256 . 285 182 . 0

Gatewa_l,lAddless:l o .0 .0 .0

DNSAddesss | 0 . 0 . 0 . 0
ak. | Cancel |

Enter the IP Address and the Subnet Mask for the device. If it will be talking to a device on
another subnet, enter the Gateway (router) address. If it will talk only on the local subnet, leave
the gateway address all zeros (0.0.0.0). Leave the DNS address at 0.0.0.0 and the Host Name
field blank.

NOTE: Make sure the EBT is on the same subnet as the computer and the PLC.
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CHAPTER 7: USING ETHERNET/IP CONFIGURATOR

WARNING! Each device on your network, including computers, routers, controllers, brains, and so on,
must have a unique IP address. Failure to assign unique IP addresses may cause catastrophic network
or hardware failures. If you don't know which IP addresses are safe to use, check with your system

administrator.

3. When the IP address, subnet mask, and other fields are correct, click OK.

Adding and Deleting Assembly Elements

1. Click the Configure Assemblies tab, and then click the Add button to open the Add/Modify

dialog box.

Add Assembly Member,

Description:

X

Class:

Digcrete [hput Point
Dizcrete Dutput Point
Analog Input Paint
Analog Dutput Paint
Load Cell Input
Scratchpad DIMT
Scratchpad REAL
Scratchpad STRING
Pulze And TPO Generator
Famp Controller

FID Loop Controller
Communication \watchdog
Pad

Qg | Caticel |

Inzstance Infarmation:

" Paint Mame

*

Maodule: |0 -

Paint:

C—

Attribute:

FeatureS elect
FeatureE nable
Featursh slue
ClearFeaturelf alue
OnlLatch

OffLatch

2. Select a class from the list on the left.

The classes available for implicit messaging in the EtherNet/IP Configurator are a subset of the
CIP classes, all of which are available through explicit messaging. For information on the CIP
classes and attributes, see form 1770, Ethernet/IP for SNAP PAC Protocol Guide.

Under Instance Information, select a point that you have configured. Otherwise, you can assign

an assembly member to a specific module and point based on their position on the rack. (See
page 106 for module and point addressing.)
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ADDING AND DELETING ASSEMBLY ELEMENTS

Add Assembly Member fg|

Description:
Class: Instance Information: Attribute:

Dizcrete Input Point

Digcrete Output Point = Paint Name FeatweSelect

Analog Input Point FeatureEnable

Analog Output Point |Ph0[|3_8|3n30[ [Mod:00 Pt Dﬂ Featurs'/ alue

Load Cell Input e ClearFeature'/alue

Scratchpad DIMNT e OnLatch

Scratchpad REAL : QffLatch
Seratchpad STRING L |

Pulze And TPO Generator g ,—_|
Ramp Controller Faint:

FID Loop Controller

Communication W atchdog
Pad

ok, | Cancel |

4, Under Attribute, select an item in the list.

The attribute list allows you to define what information from each point you want to have
passed in the implicit message. In addition to value readings, you can get other data, such as
the minimum or maximum value that the point has ever reached. This is a great way to attain
an alarm level without having to write logic in your RSLogix program that stores the high value.

5. (lick OKand follow any directions that appear for the class.

For example, the Fill Module dialog box appears for Discrete Input Point and Analog Input
Point.

Fill Module

Woould pou like to fill the rest of the module with the zame type of point?

« Yez  No

How many points does thiz module have? |4 -

6. Click OK.
7. Continue to add elements as necessary.

NOTE: If an assembly member or group of members adds up to less than 32-bits, you will need to add
padding.

8. Toadd a pad, click the Add button to open the Add/Modify dialog box.
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9. Under Class, select Pad, enter size of the pad (for example, 28), and click OK.

Add Assembly Member fz|
Drescription:
Class: Inztance |nformation: Attribuite:
Dizcrete Input Point
Digcrete Output Point Size In Bitz: |28

Analog Input Point
Analog Output Point
Load Cell Input
Scratchpad DINT
Scratchpad REAL
Scratchpad STRING
Pulze And TPO Generator
Ramp Contraller

PID Loop Controller

Communication Watchdoi
Qk. | Cancel |

The pad appears as the last member of element 0 to complete the 32-bit word.

10. To save the configuration, choose File > Save As, browse to an appropriate directory, name the
file (for example, Opto_lO), and then click Save.

11. Click the Verify tab and then click the Download button. (Or you can choose Tools > Download
Configuration to Opto 22 Device.)

12. In the Download Configuration dialog box, select the device's IP address, and then click
Download.

NOTE: Make sure that the SNAP I/O is properly configured with a SNAP PAC EB-series or R-series brain
loaded with firmware R8.3a or newer, and that the proper /0 modules are installed. Otherwise, errors
will occur.

The configuration is permanently stored in the device.

Download Configuration to Opto 22 Device le
I ame | Description | Part Ciownload |
Opta_22_IRIO 2001 e

ear Settings
Close
Timeout [msec):
F | IR 10000
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13. When the configuration has downloaded successfully, click Close.

# Download Configuration to Opto, 22 Device

M arne | Description | Part Address List | |Download|

Opto_2Z2_IRID 2001 192168.0.26
Clear Seftings
Closet

Timeout [meec]:

¢ > 10000 << Details

Configuring Device: 192.168.0.260
9 points successfully configured.
1 of 1 PID Loops successfully configured.
16 of 16 Azzembly Instances successfully configured.
Configuration saved to flash
Device: 132 168.0.26 Complete

Moving Assembly Members

The Up and Down arrows allow you to move assembly members up and down in the assembly. For
example, if a pad is in the wrong place, some of the assembly members will be highlighted in yellow
as shown here:

Configure 1/0 Modules & F'oints] Configure PID Loops  Configure Azsemblies ]\-"erif}l ]

Azzembly Instance: 101
102 1103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 | 111 [ 112 | 113 | 114 | 115
Description:
Azzembly Members:
tt | DINT | Bit | Size | Class | Instance | Attribute
0 0 0 1 Discretel nputPaint diSwitch_D0 Maod:00 PEO0 Yalue
1 0 1 1 Dizcretel nputPaoint diSwitch D1 Mod:00 PL01 Value
2 0 2 1 Dizcretel nputPoint diButton_Ct2 Mod00 PEOZ  Value Dielete
3 0 3 1 Dizcretel nputPoint diButton_Ct3 Mod00 PLOZ  Walue
4 0 4 32 AnaloglnputPoint aPID_Input Mod:03 PEOD  alue adify
5 il 4 32 AnaloglnputPaoint aiRoom_Temp Mod:03 Pt alue
B 2 4 2 Pad L Up and Down
- arrows
< | &
Ihstance Size: IDINT 2 [125 Max)
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To move the pad, select it and click the appropriate arrow to move the pad into its proper place.

Configure [/0 Modules & F'oints] Configure PID Loops  Configure Assamblies ]Verif}l ]

Aszzembly Instance: 101
100 102 | 103 | 104 | 105 | 106 | 107 | 108 109 | 110 111 [ 112 | 113 | 114 | 115
Descrption;

Azzembly Members:

# | DiNT | Bit | Size | Class Instance Attribute

0 0 0 1 DigcretelnputPoint diSwitch_D0 Mod:00 PEOD Walue Add
1 0 1 1 DigcretelnputPoint diSwitch_01 Mod:00 PEOT - Walue

2 i] 2 1 DizcretelnputPaint diButtor_Ct2 Mad:00 P02 Walue Delete
3 0 3 1 DizcretelnputPaint diButton CE3 Mod:00 PEO3 Walue

2 O 1= Madify
5 1 a a2 AnaloglnputPaint aFID_lnput Mod:03 PEO0 fAdalue

B 2 0 32 AnaloglnputPoink aFoom_Temp Mod03 PL..  ifalue

J=T]
=]

The input assembly instance is now once again formatted properly with 32-bit words.

Viewing a Configuration Report

Available in the Tools menu are reports that provide a snapshot view of the configured assemblies
and I/0.

An Assembly Configuration Report shows all of the entries contained in the current assembly
instance, including the element number, bit size, and description. It also indicates any errors and
whether or not the assembly is configured properly for download. It is helpful to check for errors in
this report before you download the configuration to the device.

B AssemblyConfigReport.txt - Notepad
File Edit Format View Help

pevice: SNAP_PAC_R Type: SNAP-PAC-R1 IP address: 10.182.64.115 A~

ASSEMBELY WVERIFICATION
Total Assembly members: 7 (4086 Max)
Total Assembly Size: 2 DINTs (125 Max)

A11 assembly Instances are configured properly! ok to download this assembly.

ASSEMELY DETAILS

Assembly Instance 100, Size: 2 DINTS

# DINT  BIT SIZE  CLASS TNSTANCE ATTRIBUTE

0 0 0 1 DiscretecutputPoint Alarm  Mod:01  PE:0O value

1 o 1 1 DiscretecutputPoint Freezer_ooor_status Mod:Ol  Priglvalue

2 ] 2 1 Discreteoutputroine Inside_Light mod:ol Pr:02  value

3 0 3 1 DiscreteoutputrPoint outside_Light Mod:01 PL:03 value

4 4] 4 28 Pad

5 1 0 16 AnalogoutputPoint Fuel_bDisplay mMod:02 pPt:00  value .
[} 1 16 16 Pad
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The I/0 Modules and Points Configuration Report lists the modules and points configured for the
selected device.

B |0ConfigReport.txt - Notepad
File Edit Format View Help

Device: SMAP_PAC_R Typa: SNAP-PAC-RZ IP address: 10.120.45.115 A~

[00] Digital Input (white) SWAP-IDCSD
[00? Emergency_switch

[01] pigital output (Red)  SNAP-ODCHSRC
[00? Alarm
[01] Freezer_Dpoor_Status
[02] Inside_Light
[03] outside_Light

[02] analog output (Green) SNAP-AOWV-27
[00] Point2_O_SNAP_PAT_R
[01] Point2 1 SMAP_PAC_R

[03] Aanalog Input (Blue) SNAP-AICTD
[00] POint3_O_SNAP_PAC_R
[01] Point3_1_sMAP_PAC_R

[04] Analog Input (Blue) SHNAP-ATV
[00] Point4_0_sSMAP_PAC_R
[01] Pointd_1_sMap_PaC_R

To view a configuration report:
1. Inthe device tree, select an Opto 22 device.

‘r. EtherMetfIP Configurator - Opt

File Edit Tools View Help

= | ?
-- Add new device...

Select an o

Opto 22 device +- SHAP_PACH

+- SMAP_PAC_S1
-I- Discovered Devices
0o-A0-30-00-90-F5

2. From the Tools menu, choose either Assembly Configuration Report or I/O Modules and Points
Configuration Report.

A text file opens showing the configuration report.

Configuring PID Loops

PID loops (or simply PIDs) are used to drive an input (a process variable) toward a particular value
(the setpoint) and keep the input very close to that value by controlling an output. For example,
consider temperature control, where the input is a measurement of ambient temperature, the
setpoint is the desired temperature, and the output is a heater. The PID for this system will use a
mathematical formula that controls the output to maintain a desired temperature, efficiently adjust
to changes in setpoint, and compensate for changes in load, such as the influx of cold air. In this
example, a temperature sensor (analog input), a thermostat (analog input), and a heater control
(analog output) are components of one system, controlled by a PID loop.

This guide assumes that you are already familiar with using PIDs. PID calculations are complex and
the physical qualities of systems suitable for PID control differ greatly. This guide includes only basic
information for configuring PIDs.

SNAP PAC I/0 units support 96 PID loops. PIDs can control isolated systems or be part of cascaded
systems where one loop controls the setpoints or input variables of others.
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Adding a PID Loop

The PID operates at the I/O unit, independently of the controller. Once configured and downloaded
to the brain, a PID operates until the I/0 unit loses power. Remember that changes are not written to
the 1/0 unit until the configuration is downloaded to the Opto 22 device. Each PID loop must be
individually configured and tuned.

Tuning steps are described in “Inspecting and Tuning PID Loops” on page 92. For additional
information, see form 1641, OptoTutorial: SNAP PAC PID.

1. In EtherNet/IP Configurator, select the Opto 22 device, and then click the Configure PID Loops
tab.

Configure PID Loops tab
# 96pidloops - EtherNet/IP Configurator |Z||E|r‘5__<|
OptO 22 File Edit Tools Wiew Help
device 0= | ?
-™“dd new device... - |
+ Corfigure 110 Modules & Point: - Configure PID Laops l Configure Assemblies] Werify ]
+- i0SEHDAPIDSE | |
-I- Discovered Devices # | Name Input Setpai A
Lowest 00-A0-30-01-30-93 00 pidSSyout_0000 FLC PLC
f—™ot Uzed
Unused 02 Mot Used%
number 03 MotUsed
04 Mot Used
05 Mot Used
06 MotUsed
07 MotUsed El
08 MotUsed L]
Ready MM

2. Double-click the lowest unused number to open the Add PID Loop dialog box.
3. Complete the Add PID Loop dialog box as detailed below, and then click OK.
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CONFIGURING PID LOOPS

Add PID Loop X
A — —— Marmne: |
B ——1—— Description: |
C ——Input ||,-'|j Paint j |ao\Fout55_DDDD ﬂ [~ Square Roo——1——D
E —{ LowRange: |0 High Range: |10
F ——— Setpaint: ||,-'D Paint j |ao\-‘0ut55_DDDD ﬂ
G Dutput: ||.-"D Pairt j |a0V0ut55_DEIEID ﬂ
H ———— Lower Clamp: |-10 Upper Clamp: |10
| ————— Min Change: |0 Max Change: |0
Output options far when the input iz out of range

[ Switch to manual made when input goes out of range:
J - A

[ Farce output when input iz aut of rangs (auba mods anly)

N
K —3— algarithm: |Welacity - Type © + | Gain: |'| Feed Fud Initial: |0 o)
L —— Mode: At w | |Tunel: 1} w Feed Fwd Gain; |0
M—1 Scan Rate: |1 sec. (TuneD: |0 ) P
Ok | Cancel |

N
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Name: Type a unique, descriptive name for the PID. The name must start with a letter and
may contain letters, numbers, and underscores (spaces are converted to underscores).
Description: (Optional) Enter a description of the PID.

Input: Select the type of input: I/0 Point, PLC, or PID Output.

- Ifthe PID’s process variable comes from an I/0 point on the same unit, select 1/0 Point.
Choose the point from the drop-down list or type a point name to configure a new
point.

- Ifthe PID's process variable comes from the Allen-Bradley controller, select PLC. Enter
an initial value for the input.

— Ifthe PID’s process variable is the output of another PID on this brain (a cascading
control loop), select PID Output. Choose the PID from the drop-down list.

Square Root: (Optional) If you chose I/0 Point or PID for step C, check this box if the error

should be calculated based on the square root of the process variable (applies to flow

control systems where volumetric flow is proportional to the square root of a signal from a

flow transducer).

Low/High Range: Set the valid range of the process variable by entering the low range and

the high range. (See Output Options for optional responses to out-of-range input.)

Setpoint: Choose the source for the setpoint: /0 Point, PLC, or PID Output.

- To control the setpoint using a device (on the same brain) such as a potentiometer,
select 170 Point; choose an I/0 point from the drop-down list or type a new point
name.

— To control setpoint using the Allen-Bradley controller, select PLC. For Initial Value, enter
the most common operating value.
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- Ifanother PID loop will control the setpoint, select PID Output and choose the PID
from the drop-down list.

Output: Choose the destination for the PID output: I/0 Point or PLC. (To use the output for
controlling the setpoint or input of another PID, choose PLC.)

Lower Clamp/Upper Clamp: Enter upper and lower clamp values to prevent the output
from exceeding a desirable range. These values should equal the range of the output point,
if used. Or choose values to make sure that the output device doesn't shut off (for example,
keeping a circulation pump running regardless of the PID output) or that the output never
reaches a destructively high setting (for example, keeping a motor below maximum).

Min Change/Max Change: (Optional) Enter minimum and maximum change values. The
output won't respond until the minimum change is reached (for example, you may not
want a heater to turn on to correct a 1 degree error). Maximum change prevents too drastic
a change in output (for example, you could limit the increase in a pump's output to prevent
pipe breakage). The default for both minimum and maximum is zero, which disables the
feature.

Output Options: Choose how the PID should respond if the input goes out of range. To
have RSLogix logic or an operator respond, check Switch to manual mode. To force the
output to a specific value, check that option and type the output values.

NOTE: If both boxes are checked (forced output and manual mode), the output will be forced and the
PID put into manual mode; but if the PID is already in manual mode, the output will not be forced.

If neither box is checked and the PID input goes out of range (as defined by E— High/Low Range) then
the output will freeze, but only while the input is out of range.

K Algorithm: Choose an algorithm: Velocity (Type C), ISA, Parallel, or Interacting. For details

L

on algorithms, see “Algorithm Choices”on page 91.

Mode: Choose the Mode you want the PID to be initialized to. The main difference between
Automatic and Manual mode is that in Manual mode the PID loop stops its mathematical
calculation. In both modes the PID's output value is still copied to the analog output.

- Auto mode: The PID makes calculations based on the difference between the input
and the setpoint resulting in changes to the output, which causes the input to move
toward the setpoint.

— Manual mode: The PID stops making changes to the output, but continues to write
the PID output to the analog point (or configured destination for the PID output).
Manual mode allows RSLogix logic or an operator to control the PID output, which in
turn is written by the PID loop to the analog point (or configured destination of the
PID output).
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NOTE: If the value of the analog point or configured destination is changed, it will be
overwritten by the PID output.

PID

Setpoint

Input Output \ﬁ

Scan Rate: Enter a scan rate to determine how often the input is scanned and the controller
output is calculated. Minimum value is 0.001 (1 ms). Scan time should be greater than
system lag (the time it takes for the controller output to have a measurable effect on the
system). Also consider other PIDs and tasks on the brain competing for processing power.
Gain: Type a positive or negative value for Gain. Heating systems usually require a negative
value and cooling systems a positive value.

NOTE: Gain is usually refined during the tuning process.

Fd Fwd Initial/Fd Fwd Gain: (Optional) Enter Feed forward Initial and Feed forward gain
values if you need to offset the controller output in your application. These values are
constants that are multiplied and added to the controller output; often they are not used in
PIDs.

Tune I/Tune D: (Optional) Type Integral and Derivative settings if you know the desirable
settings. However, Integral and Derivative are not essential to basic configuration and are
better determined in the tuning process.

Changing a PID Loop

You can change the PID loop's configuration and its position in the 1/0 unit.
1. In EtherNet/IP Configurator, select the Opto 22 device, and then click the Configure PID Loops

tab.

The Configure PID Loops tab lists all configured PID loops. Remember that the number of PID
loops available depends on the Opto 22 device.

# 96pidloops - EtherNet/IP. Configurator
File Edit Tools View Help

0= ?
-I- Add new device... -
Selected +|- in5SVouk Corfigure /0 Modules & Points - Configure PID Laops l Configure Azsemblies ] Ll;
. — +|- inSEHDAPIDIG
deV|Ce ) Discovered Devices # Marne |nput Setpoint A
00-A0-30-01-30-99 00 [ pid0000 [ aisBHDA D000
01 pid0001 &lBEHDA_0001 PLC 4
02 pid0002 alBEHDA,_0002 PLC Delete
03 pid0003 alBEHDA,_0003 PLC Q
04 pid0004 alBEHDA,_0004 PLC Modify
05 pid0005 alBEHDA,_0005 PLC 4
06 pid0006 aiBEHDA_DD0E  PLC = Up- and down-
07 pid0007 alBEHDA,_0007 PLC =
08 pid0002 alBEHDA,_0100 PLC = arrows

Ready
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PID loops are scanned by the 1/0 unit in the order that they appear in this list.

2. Tomove the PID loop to a different position on the I/0 unit, use the up- and down-arrows in
the dialog box.

3. Tochange the PID loop’s configuration, double-click its name to open the Edit PID Loop dialog
box. Change the fields as necessary.

For help in completing the fields, see “Adding a PID Loop” on page 87.

Deleting a PID Loop
Only PID loops that have a reference count of zero can be deleted. Be careful when deleting PID

loops; you cannot undo a deletion.

1. In EtherNet/IP Configurator, select the Opto 22 device, and then click the Configure PID Loops
tab.

2. Right-click the name of the PID loop and choose Delete from the pop-up menui.
The PID loop is deleted.

You can also delete a PID loop in the Configure PID Loops dialog box by highlighting it and
clicking Delete.

Algorithm Choices

When you configure a PID loop, choose one of these algorithms':
«  Velocity (Type C)

« ISA

+  Parallel

« Interacting

Velocity (Type C) is typically used to perform velocity control. The ISA, Parallel, and Interacting
algorithms are derived from the article “A Comparison of PID Control Algorithms”by John P. Gerry in
Control Engineering (March 1987). These three equations are the same except for the tuning
coefficients; converting from one equation to another is merely a matter of converting the tuning
coefficients.

The following obsolete algorithms support PID loops configured before PAC Project R9.5 (for details, see Opto-
KnowledgeBase article KB82058):

« Velocity (Type B) Obsolete

«ISA (Obsolete)

- Parallel (Obsolete)

- Interacting (Obsolete)
You can continue to use these obsolete algorithms, but Opto 22 recommends you use the new algorithms
when configuring new PID loops.
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INSPECTING AND TUNING PID LOOPS

Key to Terms Used in Equations

Process variable: the input to the Derivative tuning parameter. In units
PV PID ’ P TuneD of seconds. Increasing magnitude
increases influence on output.
SP Setpoint Output Output from the PID
InL(_) , Range of the input Err 1 The Error (PV — SP) from the previ-
InH1 - ous scan
outLo Integrator. Anti-windup is applied
OutHi ? Range of the output Integral after the output is determined to be
utne within bounds.
Gain Prqportlonal tuning pargmeter. PVL, PV2 PV from the previous scan and the
Unitless. May be negative. scan before that.
Integral tuning parameter. In units ) . . .
Tunel of seconds. Increasing magnitude ScanTime Actual scan time (time since previ-
. . ous scan)
increases influence on output.

Equations Common to All Algorithms

Err = PV - SP

Span = (OutHi - OutLo) / (InHi - InLo)
Output = Output + FeedForward * TuneFF

Equations Common to ISA, Parallel, and Interacting

Integral = Integral + Err

TermP = Err

Terml Tunel * ScanTime * Integral
TermD = (TuneD / ScanTime) * ( PV - PV1 )

Velocity (Type C) Algorithm
ATermP = ( PV - PV1 )
ATerml = Tunel * ScanTime * Err

In this part of the formula, you adjust Tunel.

ATermD = TuneD / ScanTime * ( PV - 2 * PV1 + PV2 )
In this part of the formula, you adjust TuneD.

Aoutput = Span * Gain * ( ATermP + ATerml + ATermD )
In this part of the formula, you adjust Gain.

ISA (or “Ideal”) Algorithm
Output = Span * Gain * ( TermP + Terml + TermD )

Parallel (or “Independent”) Algorithm
Output = Span * ( Gain * TermP + Terml + TermD )

Interacting (or “Classic”) Algorithm
Output = Span * Gain * ( TermP + Terml ) * ( 1 + TermD )

Inspecting and Tuning PID Loops

Using EtherNet/IP Configurator, you can view PID loops and tune them. This section gives you basic
steps for inspecting PIDs, determining system lag, and tuning PIDs. See also, Opto 22 form 1641,
Optolutorial: SNAP PAC PID, which we highly recommend for detailed information on PIDs on
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Ethernet-based I/0 units. Form 1641 is available for download from our website at
WWW.0pto22.com.

Inspecting a PID

1. With a configured PID downloaded and running on the brain, click the Configure PID Loops
tab.

2. Highlight the PID, and then click the Tuning button.

2.5 "pid0” - View PID Loop (scanning)

Mame: |pidD Errar: |N0ne
Input: 79.2753 Gain: -15 ScanBate: |3 IEC, tMode: |Auta El:
Setpoint |79 Tunel: |0.05 Scan Counts: [112783

Output;  |2.252521 Tune D: |0.02

Click a tab to see or
Plot | 140 Details | Mise. Details | Velaciy Algorith |

change additional data.

Setpoint and Input plot. —— Ihput

Adjust resolution using the
Input Axis button below

the plot. Click and drag on
the scale to move the line.

Output plot.
Adjust resolution using

5.0

the Output Axis button.
P _.___'__'_,_r""‘

Click and drag on the
scale to move the line. 5 jrr-—-‘

Time axis. Adjust resolution 0343000 0 044000 0344300 0345000 0345300
using the Time Axis button.
Clickand drag leftorrightto

see other times. Closs | | 4

[ Data  » ][Input.t‘-‘mis » ][Dutput Bxisp ][Time.-’-\xis 3 ]

3. Vieworchange PID parameters as necessary. Click the other tabs to see additional data. To tune
the PID, see page 98.

4. Tosave, copy, or print the current plot, click the Data button and choose from the popup menu.
5. Tosave changes to any of the PID configuration parameters, click Save Tuning.

Determining System Lag

You can directly control the PID output to determine system lag, which is essential to setting the PID

scan rate. Also see Opto 22 form 1641, Optolutorial: SNAP PAC PID, available for download from our

website at www.opto22.com.

1. Determine two significantly different output settings that are within the capabilities of your
system.
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2. With a configured PID downloaded and running on the brain, click the Configure PID Loops
tab.

3. Highlight the PID, and then click the Tuning button.

3.5 "pid0” - View PID Loop (scanning)

Mame:  [pidd Ermar: |Mone
Input: 79.2753 Gain: 15 ScanBate: |3 ZEC. Mode: |Auta 3:
Setpoint: |79 Tunel: |0.05 Scan Countg: 172783

Qutput  |2.252521 Tune D: |0.02

Plat | 140 Details | Misc. Detais | Welocity Algorithm |

Input

1 —T

s
I e —

03:4 09 0 0944000 0944300 0945000

[ Data  » ][Input.&xis » ][Dutput.t‘-‘mis) ][Time Bz B ]

Cloze | |

4. Setthe Mode to Manual (if not set already) and click Apply.
5. Inthe Output field, type one of your two output settings and click Apply.

Use an output value typical of your system but low enough to allow you to change output by
20%.

6. Reset your time axis, if necessary, by clicking the Time Axis and choosing from the popup
menu. Then choose Reset Scale Tracking from the same menu.

The span setting varies according to your system; a 3-minute span is often suitable. Until you
are familiar with the PID plot, it is recommended that you avoid using the shortest settings
(10-seconds or T-second). After you've observed a change in the input, you can zoom in on the
graph, which is described later.

7. Wait for your system to stabilize.
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The system is stable when the In

put value does not vary significantly (some drift can be

expected). Stabilization may take several minutes, depending on the system.

'::5"TemperalureCnntrnl“ - Yiew PID Loop (scanning)

Mame: |pidD
Astable system exhibits little
. y 1 e 7732674 Gairn:
change in the Input value, )
which is shown numerically AT | fine
Output; |30 Tune

and graphically.

Wiew 200%
Wiew 100%

w105

Plat | 140 Details | Misc. Details | Velacity Algorithm |

Reset Scale Tracking

View S50%: Span
View 25% Span

View 1% Span

Cenker on Input

Eror: |N0ne
R Scan Bate: 1 e, Mode: JAuta El:
I |0 Scan Counts: | 249642
D: |0

Span
Span

1an

Adjust resolution of the /Mcemr il
Input Axis by clicking the
Input Axis button. i | | Q

setting of 1 or 5 percent.

down until the plot is visible.
10.

Increase the resolution of the Input Axis by clicking the Input Axis menu and choosing a span
Center the Input Axis, if necessary, by clicking the red line at its left end and dragging it up or

Under the Time Axis menu, choose Reset Scale Tracking.

This is a precautionary step, as changing settings on the plot can fix the plot at a certain point
in time. Resetting the time axis ensures that you are viewing the real-time values.

11.

In the Output field, type the other of your two output settings and click Apply.

A 20% percent increase is a moderate, detectable change for most systems. Your system may
require a larger or a smaller change to stay within safety constraints.
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12. Wait for a discernible change in the Input axis.

Plat | 1/0 Details | Misc. Detais | Velacity Algerithm |

The Input axis (indicated by
the upper white arrow
added to this picture)
begins to respond to the
change in output (lower
white arrow).

[ Data  » ][InputAxis » ][Dutput.&kis} ][Time.t‘-‘mis » ]

13. Increase the resolution of the Time Axis by clicking the Time Axis button and choosing a lower
percentage, such as View 1 Minute Span.

14. Scroll the Time Axis to locate the point at which you changed the Output.
Both the time and input axes should display the point at which the Output changed, the lag,

and the point the input changed. If not, adjust the Input axis and Time axis, until this
information is displayed.

Flot | 1/0 Details | Mise. Details | Velacity Algorthm

[ Data  p ][InputAxis 3 ][Dutputhxis} ][Timeﬁ-\:-:is 3 ]

15. From the Data menu, select Cursor.

The data cursor, a line with a value bar attached to it, appears on the plot.
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16. Right-click the data cursor and choose Delta X from the Style submenu, as shown below.

Plot | 140 Details | Mise. Details | Velacity Algorithr |

Input

Channel
4 W Yalue H-Y

Flip Alignment Delta ¥

[ Data  p ][Input.-’-\xis 3 ][Dutput.-’-\xisb ][TimeAxis »

17. To measure the system lag (the time between the change in output and the change in input),
click and drag the first vertical red bar to just after the output change. Drag the second bar to
just before the change in input.

The Delta X cursor displays Plat ] 1/0 Details | Misc. Details | Welocity Algorithm
the time difference between
the two vertical bars.

Drag the first bar into position
after the Output change.

Drag the second bar to a
position just before the
change in Input.

[ Data  » | [InputAsiz » | [Output dsis b | [ Time Asis » |

If you are unable to get the precision you want, you can view the plot at a lower time span,
such as 10 seconds. You will need to reposition your plot and the measurement bars of the
Delta X cursor.

The example above shows a system lag of 1.88 seconds. Generally, a suitable scan rate can be
anywhere from one-third the system lag to two times the system lag. Considerations in setting scan
rate are:
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+  Slower scan intervals may be easier to tune. The PID controller has time to see the effect of the
previous output before calculating a new output.

+  Faster scan rates may be necessary to achieve the desired response. When scan intervals are
shorter than the system lag, tuning must compensate for any over-correction from the
controller output.

Tuning a PID Loop

Tuning a PID involves manipulating the P, I, and D constants in real time. The following steps should
be viewed as general suggestions to show you features that are available for tuning. We highly
recommend Opto 22 form 1641, Optolutorial: SNAP PAC PID, for more detailed information.

Form 1641 is available for download from our website at www.opto22.com.

CAUTION: Before following these procedures, make sure you know the limits of the equipment being
controlled and monitored by your PID loop. Also, make sure that these points are configured properly. Any
values suggested in these steps are for example only and must be modified according to the capabilities
and constraints of your system.

1. Make sure the following PID features have already been configured:
- Scan Rate
- Input
— Input low range and high range
—  Output
—  Output lower and upper clamp
- Algorithm

- Setpoint. If your setpoint changes during normal operation, tune your PID with the
setpoint configured to host, so you can simulate setpoints from an input point or from
another PID.

— Gain. Afinal gain constant will be determined by tuning, but before you can tune your PID,
your gain constant must be either a positive or negative number according to the type of
system you have. For example, a heating system reports a negative error when heat needs
to be applied; a negative gain constant turns this error into a positive output for the heater.
Alternatively, a cooling system reports a positive error when the input exceeds the
setpoint; a positive gain constant maintains the positive output to the chiller.

- Optional, depending on your system: Minimum and maximum changes to Output and
Output forcing when the Input is out of range.

2. With a configured PID downloaded and running on the brain, click the Configure PID Loops
tab.
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Highlight the PID, and then click the Tuning button.

2.5 "pid0” - View PID Loop (scanning)

Mame:  [pidd Ermar: |Mone
Input: 79.2753 Gain: 15 ScanBate: |3 2EC. Mode: JAuta 3:
Setpoint: |79 Tunel: |0.05 Scan Counts: [172783

Output,  |2.256252 Tune D |0.02

Plat | 140 Details | Misc. Details | Velacity Algorithm |

[ Data  » ][Input.&xis » ][Dutput.&xis} ][Time Bz P ]

Cloze | |

Set the PID Mode to Auto (if not set already) and click Apply.
Change the Setpoint, if desired, by typing a new setpoint and clicking Apply. (Setpoint must be
configured as Host.)

Depending on the type of system, your PID may maintain a setpoint or respond to changes in
setpoint. Experiment with setpoint changes again after tuning the P, |, and D constants.

Adjust the span of the input, output, and time axes according to how much change you expect
from your system. To set a span, click the axis button and choose from the popup menu.

If desired, type a new Scan Rate and click Apply.

For most systems, you should use an appropriate scan rate based on the system lag (see

"Determining System Lag”on page 93). However, you can experiment with Scan Rates before
tuning the P.1, and D constants or adjust scan rate after tuning.

|IO4AB User's Guide m



INSPECTING AND TUNING PID LOOPS

Here is an example for Scan Rate:

% “TemperatureControl” - View PID Loop (scanning)

Name:  |TemperatureCortral Enor: [Mone

Input: 80.24991 Gain: A Scan Rate: |3 ZEC. Mode: JAuta 3:
Setpaint: |20 Tunel: |10 Scan Counts: 112783

Dutput; |0 Tune D: |0

Plat | 1/0 Details | Mise. Details | Velaciy Algorithm |
The lag for this system was

determined to be about 2
seconds. The left half of the
plot reflects a 0.5-second
scan rate, while the right half §0.00
shows a 3-second scan rate.
Notice both scan rates have
the same effect on the input;
however, the 3-second scan
rate is using less of the
ProCessor's resources.

Data  p ][Input Bz B ][Dutput.ﬁ.:-:is) ][Time.&xis » ]

Cloze | |

8. Experiment with gain settings by typing a new value in the Gain field and clicking Apply.

The easiest way to tune most PIDs is to experiment with the gain constant first. Try various
gains to see how well the system stays at setpoint and responds to setpoint changes.
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With only a gain constant
applied, the input often
stabilizes at an incorrect
value. In this heating
example, a gain setting of
-30 drove the input close
to the setpoint, but
subsequent increases
failed to eliminate the
offset. It is time to try
integral constants to
eliminate the offset error.

CHAPTER 7: USING ETHERNET/IP CONFIGURATOR

The white arrows in the example below show where gain constants of -2, -5, -10, and -20 were

applied:

bl

2= "TemperatureControl” - View PID Loop, (scanning)

Mame: |TemperatureE0ntmI Errar: |N0ne
Input: 75289 Gairn: -20 ScanBate: |14 3EC.
Setpaint; |90 Tunel: |0 Scan Counts: |112783

Output;  |B1.7775 Tune D: |0

Plot | 140 Details | Misc. Details | Velacity Algorithm |

[ Data  » ][Input.&xis » ][Dutput.&xis} ][Time Bz P ]

Mode: |Auta El:

|nput

Cloze | |

e

In this example, a gain setting of -30 revealed an offset error:

Flot | 140 Details | Misc. Detaik | 154 Algorithm |

90,00

[ Data

3 ][Inputﬁ-\:-:is » ][Dutput.t\:-cisb ][TimeAxis » ]

Ihp
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9. Experiment with the integral constant: in the Tune | field, type a number between 0 and 1 and
click Apply. (Your PID may require larger numbers.)

In this example, an integral constant of 0.1 corrected the offset error.

The far left side of the plot Plot | 1/ Details | Misc. Details | 154 Algorithm |
shows the offset before an

integral constant of 0.1 was
applied. This setting eliminated
the offset. In many applications,
a minor fluctuation around the
setpoint is acceptable, and
these applications use gain and
integral only. In some
applications, however, the
fluctuations at the setpoint
indicate that the gain is too
high (too much gain makes a
system unstable) or that a
derivative constant is required.

[ Data  » | [Inputdeis » | [Qutput dsisk | [ Time Asxis » |

10. If derivative correction is needed, experiment with the derivative constant: in the Tune D field,
type 1 and click Apply. (Your PID loop may require a larger number.)

In this example, a derivative of 10 makes a noticeable difference in keeping the input near the

setpoint.
Many PID systems are GHECUVEB/ 3.¢ "TemperatureControl” - View PID Loop (scanning)
controlled with gain and integral Name:  [TemperatureContiol Error: [Mone
constants only and no derivative It [3002628 G |30 ScanBate: 14  sec  Mode [BUEIIII]
constant. In this example, the gain and Setpoint: [30 Tunel: [0 ScanCounts [B1281
integral settings are maintaining the Quiput: [B571083  TuneD: |10
temperature at 0.06 from setpoint. To Plot | 10 Details | Misc. Detais | Velacity Algorthm

demonstrate the effect of the
derivative constant, the resolution of
the input axis was increased to show a
1 percent span. At this resolution, the
plot reveals changes of 0.01 degrees F.

The left side of the plot shows the
effect of gain at -30, integral at 0.1, and
no derivative constant. The arrow
shows when a derivative constant of 10
was applied. The right side of the plot
shows how the derivative constant is
keeping the input closer to setpoint.

T e ML Ay

[ Data  » ][InputAxis » ][DutputAxis) ][TimeAxis » ]

Cloze | |
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11. Click Save to save your tuning parameters to the configuration.

Changes are lost unless you save them. You may wish to save your tuning parameters when
you see any improvement in performance, even if they are not final.

EtherMet/IP Configurator X

The Following values will be permanently saved to the device:

‘} "

2
Gain:

Tune I
Tune L
Scan rate:
Feed forward:
Feed forward gain:
Qutput min change:
Output masx change:

Do you want ko conkinue?

Oukput when input is under-range:
Oukput when input is over-range:

-5,000000
10, 000000
200,000000
3.000000
0.000000
0.000000
0.000000
0.000000
0.000000
0.000000

12. Click Yes.

Values are saved to the EtherNet/IP configuration file. Remember to download the
configuration to the Opto 22 device. (See “Downloading a Configuration”on page 78.)
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Using I/O Point Features

The I/0 point features available on remote /O depends on the combined capabilities of the device
(brain or on-the-rack controller). See the device's data sheet for supported features.

The following tables define the digital and analog features that are supported. For more information,
see form 1704, the PAC Manager User's Guide. See also form 1798, the SNAP I04AB Learning Center

User’s Guide.

To see a video demonstration of using I/O point features, go to the Learn tab on the Opto 22
website, www.opto22.com, and click Learn About I04AB.

Digital Features

Feature

Description

Counters

(input)—A counter keeps track of the number of times a digital input changes from off to on.
The count accumulates until it reaches the maximum count available in the remote 1/O or until
you reset the counter to zero. For example, to count the number of widgets produced per shift,
you would clear the counter at the start of each shift and read it at the end of each shift.

For points on a 4-channel module, the speed of the counter depends upon the brain or con-

troller’s capabilities and the speed of the module used. For points on a high-density module,
counting is done in the module.

Frequency
measurement

(input)—Frequency is the speed with which a digital point changes state and is usually mea-
sured in counts per second. For example, reading the frequency can help you determine the
speed of rotating machinery.

Latches

(input)—When the value of a digital input point changes from off to on, an on-latch is automat-
ically set. While the value of the point may return to off, the on-latch remains set, as a record
of the change, until you clear it. Similarly, an off-latch is set when the value of a digital point
changes from on to off, and it remains set until cleared.

Period
measurement

(input)—Period refers to the elapsed time for a complete on-off-on transition on a digital point.
Measurement starts on the first transition (either off-to-on or on-to-off) and stops on the next
transition of the same type (one-time or continuous or both).

Pulse duration

(input)—A pulse is a brief on (or off) state, usually repeated at a specific interval. The brain

tional output
(TPO)

measurement | can measure the first pulse, that is, the amount of time the input stays on (or stays off).
(input)—A quadrature counter requires a SNAP quadrature input module, which is attached to

Quadrature the encoder device. The module sends a pulse to the remote 1/0O upon each change in

counters quadrature state, and the remote I/O counts the pulses and keeps track of the direction and
rotation.

States (input and output)—Automatic, not configurable. A digital point is either on or off. You can read
the current state of a digital input or write an on/off state to a digital output.

Time-propor- (output)—Time-proportional output varies the duty cycle and the percentage of on time within

that cycle. TPO is often combined with a PID loop and used to control the output, for example
in a heater or oven.

Watchdog

(digital and analog points)—A watchdog monitors communication to the device. If nothing
accesses the port for the length of time set in the watchdog, the remote 1/0 automatically sets
designated digital and analog I/O points to the values you have determined.

A watchdog helps make sure that a communication failure doesn 't result in disaster. If no
communication is received for the length of time set in the watchdog, the watchdog makes

sure the process is automatically brought to a safe state. For example, a valve could automat-
ically close to avoid completely emptying a tank.

|O4AB User's Guide



http://www.opto22.com/
http://www.opto22.com/site/about_io4ab.aspx
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Feature Description
Digital totalizers track the total time a specific input point has been on or off. For example, you
Totali could track how long a pump, fan, or motor has been on. Digital totalizers are useful for peri-
otalizers

odic maintenance. Before using a totalizer, you must configure the point with this feature. The
availability of totalizers depends on the brain; see the brain’s data sheet for more information.

Analog Features

Feature

Description

Average filter
weight

(analog inputs)—A filter weight smooths analog input signals that are erratic or change sud-
denly.

Clamping

(analog output)—Clamping limits values that can be sent to analog output points so they do
not go above or below a specific value. For example, if you are using a 0—10 VDC output
module, but the device attached to one of its points can only handle a maximum of 5 VDC,
you can set an upper clamp of 5 VDC for that point. The values for upper and lower clamp
are set in engineering units.

Minimum and
maximum
values

(analog input)—Minimum and maximum values are sometimes called peaks and valleys.
You can read these values at any time, for example, to record minimum and maximum tem-
peratures. You can also reset min/max values. For example, if you want to record the maxi-
mum temperature at point 2 in each 24-hour period, you must reset the values after they are
read each day.

Offset and gain

(analog input)—Offset and gain calculations are used to calibrate analog points. If a -50 mV
to +50 mV input receives signals that are slightly off (not exactly -50 mV at the lowest point,
for example), the offset and gain can be calculated so that values will appear accurately
when read.

(analog points)—Proportional integral derivative (PID) loops are used to drive an input

PID loop toward a particular value (the setpoint) and keep the input very close to that value by con-
control . .
trolling an output. PID loops are often used in temperature control.
(analog output)—Some devices attached to analog outputs should not be abruptly stepped
Ramping up or down, because a sudden change might damage the equipment or cause other prob-
lems. Instead, you can gradually ramp the device up or down to the desired value.
Scaling (analog input and output)}—Analog input and output points can be scaled as needed. For

example, you can scale a -5 V to +5 V input point to reflect 0% to 100%

Thermocouple
linearization

(analog input)—Automatic, not configurable. The remote I/O automatically converts the ther-
mocouple junction's millivolt values into temperature values, so you don’t have to. Choose

the appropriate module and make sure you configure the point as the correct thermocouple
type (E, K, etc.) for your purpose.

Watchdog

(digital and analog points)—A watchdog monitors communication to the device. If nothing
accesses the port for the length of time set in the watchdog, the remote I/O automatically
sets designated digital and analog I/O points to the values you have determined.

A watchdog helps make sure that a communication failure doesn’t result in disaster. If no

communication is received for the length of time set in the watchdog, the watchdog makes
sure the process is automatically brought to a safe state. For example, a valve could auto-
matically close to avoid completely emptying a tank.
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Referencing I/0 Points on SNAP PAC Racks

This section shows input and output point numbers for SNAP PAC mounting racks, which can hold
upto4,8,12,or 16 Opto 22 SNAP I/0 modules.

Fach module contains 1 to 32 points (channels), depending on the module. Examples of modules
are shown in the following diagram.

NOTE: Each channel of a SNAP PAC I/O module provides connectivity to one point of I/O. Each channel of
a SNAP PAC communication module provides connectivity to one communication port.

/I\/lodule positions

Module position 0, 4-ch digital:

Points: n

Module position 6, high-density digital:

0
1
2
3
X 4
5
6
7
8

Points:‘31|<7| 0 \

<«— Module position 8, analog:

O

Points:‘7‘6|5|4|3|2|1|0‘

110
11
B 12 4«—Module position 12, analog:
{° pons[ 7 [ 0]

14
15

Module position 14, serial:

Ports: El
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A: Supported Allen-Bradley
Platforms

Opto 22 supports using the ControlLogix” and CompactLogix™ controller platforms, V13-17, with
Opto 22 SNAP I/0. Both of these platforms support Implicit Messaging (also known as I/0O
messaging) and Explicit Messaging.

The following Allen-Bradley platforms also support EtherNet/IP. While some controllers in these
platforms only support explicit messaging, Opto 22 may be able to assist you in using them.

«  MicroLogix™ 1100 and 1400 (Series B FRN4 or newer)

NOTE: Some Allen-Bradley controller platforms have only specific models that support EtherNet/IP or
require an adapter module or card.

For a complete and up-to-date list of Allen-Bradley platforms that support EtherNet/IP, and more
information on which platforms support Implicit Messaging or Explicit Messaging only, contact
Rockwell Automation.
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B: Using Counts

This appendix describes using counts with EtherNet/IP and linearizing the Pt100 and Pt1000 probes
from resistance.

In this Appendix

Using Counts With EtherNet/IP ... 109
Linearizing the Pt100 and Pt1000 Probes from Resistance........111

Using Counts with EtherNet/IP

While Opto 22's SNAP PAC I04AB implementation provides many configurable options for reading
and writing I/0 (including robust scaled units) as an Allen-Bradley user you can still use counts if you
want to. However, using counts has various limitations due to the brain’s capability to linearize the
counts provided by the modules.

How to Retrieve Counts

When creating assembly instances in the EtherNet/IP Configurator, there are two types of values for
analog inputs and outputs, rValue and Value. Selecting rValue will report the value as a 32-bit float or
a Logix REAL data type. Value is the 16-bit integer value of counts as an input.

In the SNAP PAC architecture, the notion of counts varies with the particular module being used.

Most Analog Inputs

Most SNAP analog input modules provide a counts range of 0 to 24,999 counts for unipolar modules
(which read zero to a positive valued input) and —24,999 to 24,999 counts for bipolar modules
(which read a negative to positive input range).

The analog input range determines the limits of the counts. For example, a SNAP-AIV has either a
+10VDC or a +5 VDC input range. This range is selectable in the EtherNet/IP configuration. When
set to the =10 VDC input range, 24,999 counts is 10 VDC and -24,999 counts is —10 VDC. If the
module is set to the +5 VDC, 5 VDC is 24,999 counts and -5 VDC is 24,999 counts.
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Opto 22's SNAP analog inputs also allow 10% over range. This means that for the SNAP-AIV module,
the actual maximum range is +11 VDC or £5.5 VDC. This absolute range is 10% beyond the
advertised module limit, which means the counts may have a maximum magnitude of 27,499
counts.

NOTE: Any range outside of 27,499 counts magnitude is considered an invalid and out-of-bounds
condition.

Analog Input Exceptions

This section applies to the following modules and associated modes (including any —FM designated
parts):

SNAP-AICTD

SNAP-AICTD-8

SNAP-AITM (in thermocouple mode)
SNAP-AITM2 (in thermocouple mode)
SNAP-AITM-i (in thermocouple mode)
SNAP-AITM2-i (in thermocouple mode)
SNAP-AITM-8 (in thermocouple mode)

When these modules are configured in their temperature mode, they will output counts that are 10
times the linearized temperature value.

For example, if a SNAP-AITM has a “J"thermocouple input and it is reading 123.4F, the counts
reported with 1234 (as a 16-bit signed integer).

Resistance Temperature Inputs

SNAP-AIRTD 1/0 modules (including the SNAP-AIRTD-1K and SNAP-AIRTD-10), the SNAP-AIR40K-4,
and the SNAP-AIR400K-8 are resistance modules.

Linearized temperature for SNAP-AIRTD modules is available for Pt100 and specific nickel based
probes. The SNAP-AIR40K-4 and SNAP-AIR400K-8 are strictly resistance modules but may be used
for higher impedance probes, such as a Pt1000.

To read the temperature linearized SNAP-AIRTD modules, read the scaled engineering units. If
counts are used, they will represent the input value as wire compensated ohms. Wire compensation
means that the module provides instrumentation wire resistance compensation internally. For the
SNAP-AIRTD modules, 0 counts means 0 ohms. 24,999 counts indicate 400 ohms. A 10% over range
is provided so 27,499 will be reported for 440 ohms of input resistance.

If you are using counts for the SNAP-AIRTD modules, the SNAP-AIR40K-4, or the SNAP-AIR400K-8,
you must provide your own linearization. In this case, using scaled engineering is recommended.

For additional information on determining the temperature from the probe resistance, see
“Linearizing the Pt100 and Pt1000 Probes from Resistance”on page 111.

Load Cell Inputs

When using the SNAP-AILC and SNAP-AILC2 load cell modules, only use the scaled engineering
units. These modules output a higher resolution as counts, which is too large of a number for a
16-bit signed integer (a type INT) too handle.
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NOTE: Firmware versions R8.5 and newer support the load cell module. Use the Load Cell assembly class
(not the Analog Input class) for load cell values.

Analog Outputs

SNAP analog output modules are based on 12-bits. Unipolar output modules have a range of 0
counts to 4095 counts. Bipolar have a counts range of —4096 to 4095. Analog outputs do not have
the 10% over range that analog inputs have.

Linearizing the Pt100 and Pt1000 Probes from Resistance

If you would like to use counts strictly for the SNAP-AIRTD and thermistors for the SNAP-AIR40K
modules, tables in slope-intercept format are provided below. The Pt100 probe table may also be
used for Pt1000 applications. For Pt1000 applications, divide the resistance by 10. The SNAP-AIRTD
should be used for the Pt100 and the SNAP-AIR40K should be used for the Pt1000. When using the
P11000, use the 0-5000 Ohm input range with the SNAP-AIR40K.

To use these tables, start by searching from the lowest resistance value of the table. Compare the
resistance value until you reach the last value before the table’s resistance exceeds your measured
value.

Take the slope and intercept and compute this equation using floating-point variables.
temperature = (slope from table) x (measured resistance) + (intercept from table)

To convert from Celsius to Fahrenheit, use this equation:

Temperature(F) = Temperature(C) x (1.8) + 32

For better accuracy using probes with the SNAP-AIR40K module, short the leads at the probe’s
terminal blocks and record the resistance measurement. This is the resistance offset due to the
instrumentation wiring. Subtract this value from the resistance measurement before using the
linearization table.
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LINEARIZING THE PT100 AND PT1000 PROBES FROM RESISTANCE

Table 1: 100 Ohm Nickel RTD -60 to 250 °C
Table Range 68.0 t0 291.0 Ohms

Resistance | Slope Intercept
68.0 -208.2 213121

73.0 -203.397 2.065415
78.0 -198.394 2.001275
84.0 -193.147 1.938809
90.0 -188.091 1.882628
96.0 -182.791 1.82742

103.0 -177.189 1.77304

110.0 -171.674 1.722901
117.0 -166.205 1.676152
124.0 -160.374 1.629129
132.0 -154.119 1.581747
140.0 -147.819 1.536746
148.0 -141.452 1.493727
156.0 -135.005 1.452396
164.0 -128.069 1.410108
173.0 -120.599 1.366925
182.0 -113.014 1.325248
191.0 -105.321 1.284971
200.0 -97.5315 1.246025
209.0 -89.6599 1.208362
218.0 -81.2915 1.169975
228.0 -72.4124 1.131032
238.0 -63.4985 1.093578
248.0 -54.5737 1.057591
258.0 -45.6613 1.023047
268.0 -36.3519 0.98831

279.0 -26.2247 0.952012
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Table 2: 120 Ohm Nickel RTD -80 TO 260 °C

APPENDIX B: USING COUNTS

Table Range 65.0 to 381.0 Ohms

Resistance | Slope Intercept
65.0 -182.127 1.533316
87.0 -179.959 1.508399
100.0 -176.723 1.476043
110.0 -172.557 1.438171
119.0 -167.486 1.395552
128.0 -162 1.352695
137.0 -156.357 1.311506
146.0 -150.64 1.272347
155.0 -144.621 1.233515
165.0 -138.325 1.195359
175.0 -131.967 1.159026
186.0 -125.596 1.124774
197.0 -119.322 1.092927
208.0 -112.759 1.061371
220.0 -105.979 1.030556
232.0 -99.093 1.000874
245.0 -92.0848 0.972269
258.0 -84.7268 0.943749
271.0 -76.8096 0.914535
284.0 -68.4858 0.885226
297.0 -59.9087 0.856347
310.0 -51.1933 0.828232
323.0 -42.291 0.800671
337.0 -33.3737 0.77421

351.0 -24.5218 0.748991
366.0 -15.9767 0.725644
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LINEARIZING THE PT100 AND PT1000 PROBES FROM RESISTANCE

Table 3: Pt100 Platinum RTD -200 TO 850 °C, Alpha = 0.00385
Table Range from 17.0 to 391.0 Ohms

Resistance | Slope Intercept
17.0 -242.952 2.323969
26.0 -243.957 2.362626
35.0 -245.257 2.399766
45.0 -246.907 2.436427
56.0 -248.793 24701

67.0 -250.836 2.500594
79.0 -253.104 2.529302
92.0 -255.638 2.556855
106.0 -258.572 2.584534
120.0 -261.869 2.612006
133.0 -265.501 2.639312
146.0 -269.615 2.667492
159.0 -274.242 2.696595
172.0 -279.416 2.726672
185.0 -284.944 2.756555
197.0 -290.783 2.786194
209.0 -297.182 2.81681

221.0 -304.176 2.848458
233.0 -311.804 2.881198
245.0 -319.755 2.913648
256.0 -327.971 2.945745
267.0 -336.831 2.978926
278.0 -346.374 3.013254
289.0 -356.646 3.048797
300.0 -367.181 3.083915
310.0 -377.91 3.118524
320.0 -389.366 3.154325
330.0 -401.597 3.191389
340.0 -414.654 3.22979

350.0 -427.878 3.267574
359.0 -441.182 3.304632
368.0 -455.294 3.34298

377.0 -470.266 3.382694
386.0 -482.558 3.414538
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C: Worksheets and
Calculations

This appendix provides a variety of worksheets to help you determine your system'’s requirements.

In this Appendix

EtherNet/IP TCP/IP Requirements PLC Worksheet............. 116
EtherNet/IP Multicast Requirements PLC Worksheet........... 117
SNAP PAC Connection WOrksheets.........eeeerrsecivirreeeee 118
EtherNet/IP Module Packet Rate LimMitS.............ceeeerveccrvcrrveees 119
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ETHERNET/IP TCP/IP REQUIREMENTS PLC WORKSHEET

EtherNet/IP TCP/IP Requirements PLC Worksheet

Each EtherNet/IP application should be reviewed for its TCP/IP connection requirements. The
following worksheet will assist in determining the number of connections required for each
Allen-Bradley PLC within the system.

TCP/IP Connections (for each PLC in the system)

Question Quantity
RSLogix connection to the PLC using EtherNet/IP (enter 1 here)

How many RSLinx or 3™ Party OPC/DDE Servers?

How many PAC devices will be accessed via an unconnected MSG instruction?
How many other (non Opto 22) EtherNet/IP devices?

How many Logix to other EtherNet/IP PLC TCP/IP connections?

How many remote PLCs will connect to this PLC using a TCP/IP connection?
How many Generic Ethernet Modules are defined?

Total number of TCP/IP connections (sum the “Quantity” column together)

Depending on the specific PLC or EtherNet/IP module, your application could exceed the TCP/IP
connection resources. If you are using ControlLogix, you can use additional EtherNet/IP modules.

Typically, ControlLogix modules may support 64 (1756-ENBT) or 128 (1756-EN2T or 1756-EN2F)
TCP/IP connections. CompactLogix typically supports 32 connections.

For the specific TCP/IP limitations of your PLC, see Allen-Bradley form enet-um001_-en-p.pdf.

MicrolLogix PLCs such as the 1100 and 1400 support 8 TCP/IP connections. This limit is described in
each product’s published specifications.
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APPENDIX C: WORKSHEETS AND CALCULATIONS

EtherNet/IP Multicast Requirements PLC Worksheet

Each EtherNet/IP application should be reviewed for its multicast requirements. The following
worksheet will assist in determining the number of connections required for each Allen-Bradley PLC
within the system.

Multicast Connections (for each PLC in the system):

Quantity Total
How many “Generic Ethernet Modules,” with status?
How many remaining “Generic Ethernet Modules?”
How many consumed tags to other EtherNet/IP PLCs? "2

How many produced tags to other EtherNet/IP PLCs?

Total Number of Multicast Connections (add “Total” column together)

This total reflects the total number of CIP connections required for the application. Use the latest
version of the EtherNet/IP Capacity Tool to accurately determine limits of your application. This is
only necessary in applications that have large numbers of I/0 especially when PLCs themselves are
producing and consuming tags.

NOTE: Only some of the ControlLogix EtherNet/IP modules support implicit messaging. The modules that
support implicit messaging are the 1756-ENBT, 1756-EN2T and the 1756-EN2F EtherNet/IP modules.
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SNAP PAC CONNECTION WORKSHEETS

SNAP PAC Connection Worksheets

Complete the following worksheet for each SNAP PAC brain or controller used within an EtherNet/IP
system.

EtherNet/IP SNAP PAC Multicast Connection Worksheet

The SNAP PAC brain or controller supports 16 multicast connections. If this limit is exceeded,
EtherNet/IP modules will have difficulties connecting to the SNAP PAC brain or controller.

Quantity Total
How many “Generic Ethernet Modules,” with status?
x2
How many remaining “Generic Ethernet Modules?”

Total number of Multicast Connections (add “Total” column together)

EtherNet/IP SNAP PAC Encapsulation Connections

The SNAP PAC brain or controller supports 16 CIP encapsulation connections (for EtherNet/IP). The
following worksheet will assist to determine the application requirements for each SNAP PAC device
within the Allen-Bradley system.

Typically for explicit messaging, a PLC will create one encapsulation using TCP/IP connection to the
PAC. Use only unconnected messaging (configured in the MSG instruction). This will ensure that the
PLC will not quickly exceed the encapsulation connection limit of the PAC.

The PLC will also create a UDP encapsulation connection for each implicit messaging multicast
session.

Quantity Total
Number of PLCs with Explicit Messaging access
Total Generic Ethernet Modules w/Status accessing this device x2
Total Generic Ethernet Modules accessing this device

Total Number of Encapsulation Connections Consume
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APPENDIX C: WORKSHEETS AND CALCULATIONS

EtherNet/IP Module Packet Rate Limits

Implicit Messaging Volume

To determine the total volume of packets generated by the implicit messaging, use one of the
following equations. You will need to know the requested packet interval (RPI, in milliseconds) of
each Generic Ethernet Module.

When using a Generic Ethernet Module with Status:

Packet Rate per Second (for each Generic Ethernet Module) = 4000 / RPI
When using all other Generic Ethernet Modules:

Packet Rate per Second = 2000 / RPI

The total implicit messaging packet rate is the sum of all of the packet rates of all the configured
modules on the PLC.

Explicit Messaging Volume

Explicit messaging is determined by the rate the PLC logic decides when to initiate a message
sequence. By determining the maximum number of MSG commands per second, you can use this
number to estimate the maximum packet rate as follows:

Packet Rate per Second = 2 X maximum MSG commands per second

The total packet rate generated by implicit and explicit messaging is the sum of the implicit
message packet rate and the explicit message packet rate.

10 Packet Rate = Implicit Packet Rate + Explicit Packet Rate

Typically a ControlLogix 1756-ENBT module has a maximum packet rate of 5,000 packets per
second. A CompactlLogix PLC has a throughput of 4,000 packets per second. Allen-Bradley form
ENET-APO01D-EN-P specifies the entire calculated rate should not exceed 90% of the maximum
packet rate of the EtherNet/IP module.

The calculations described above only accumulate a portion of the EtherNet/IP messaging rate. We
strongly recommend reviewing Allen-Bradley forms ENET-APO0T and 1756-RM094 to ensure that all
other sources of EtherNet/IP traffic are considered when validating your system design.

The Ethernet topology and switches are also responsible for the response rate and maximum
throughput of an EtherNet/IP implementation. We encourage you to evaluate the performance of
your Ethernet network topology.
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ETHERNET/IP MODULE PACKET RATE LIMITS
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D: Connecting with MicroLogix

This appendix provides information for connecting to a MicroLogix 1100 or 1400 PLC.

You can use a MicroLogix 1100 (Series-B) or 1400 to read and write /0O data using I04AB. Assembly
Instances configured in the EtherNet/IP Configurator may be read and written using the MSG
instruction.

Each MSG instruction must have its own RIX Extended Routing Information and Message files. Add
these files before configuring the MSG instruction in the ladder.

To add more Message files follow these instructions:

1.

© NO WU RAWN

While offline, select the data files folder in the RSLogix Micro project pane followed by a right
mouse click.

Select New...

Add a new file of the type Message.
Give the file a name such as “Message1”
If desired, enter a description.

Elements should be set to 1, the default.
Select Global, the default.

Press OK.

To add additional Extended Routing Information files follow these instructions:

1.

@ No WUk WN

While offline, select the data files folder in the RSLogix Micro project pane followed by a right
mouse click.

Select New...

Add a new file of the type Extended Routing Information.
Give the file a name such as “RIX1/

If desired, enter a description.

Elements should be set to 1, the default.

Select Global, the default.

Press OK.

Now you can add the MSG instruction to the ladder. See below for descriptions of the values when
configuring the MSG instruction.
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General Tab

This Controller

Channel:

1 (Integral)

Communication Command:

CIP Generic

Data Table Address:

Insert the address to read or write data

Number of Elements

Target Device

This is automatically set.

Message Timeout:

Extended Routing Info File:

Routing Register File (create a unique file for each MSG)

Service: Either “Read Assembly” or “Write Assembly”

Class: 4 (hex)

Instance: Use the E/IP Configurator’s Assembly Instance number (from 100 to 115)
Attribute: 3 (hex)

MSG - MG9:0 : {1 Elements)
[General | MutiHop | Send Data | Receive Data|
- This Controler Control Bils
Chorvet [iiisgal ] Ignore if timed out (TO). [0]
Comricatin Commmrt T e Break Connection (8K} [0]
Data Table Address [Receive} Awating Execution EW [0]
SiceinB i
ize in Bytes [Receive) (Send} Evor ERL ]
Target Device Message done (DN} [0]
Message Timeout: | Message Transmitting (ST} [0]
Message Enabled (EN} [1]
Local / Remote MuliHop:
Extended Routing Info File(RI<): [RE<100 ] Ertor
Sewvice: [Read Service Code (hex} [E___] Enot ex} 0
Clss ey L] (e} [L] ot
Instance [hex} [64_ | (dect
Atvbute et (5] (dect B
Enor Description
No emors
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APPENDIX D: CONNECTING WITH MICROLOGIX

MultiHop

Add Hop
From Device: This MicroLogix
From Port: Channel 1

To Address Device: | EtherNet/IP Device (str:)

To Address: (insert IP address of PAC device)

MSG - MG9:0 : (1 Elements)

General MuliHop | SendData | Receive Data|

Ins = Add Hop Del = Remaove Hop

To Address
10.192.54.46

From Device

The MSG has a limit of 124 16-bit words. However, when working with the EtherNet/IP Configurator,
there is a lower limit for each assembly. For the MicroLogix family, an assembly instance may not
exceed 62 DINTs (32-bit integers).

For additional information, see “Using Counts with EtherNet/IP” on page 109.

NOTE. MicrolLogix 1100 must use firmware FRN 4 (OS Series B) or newer to enable CIP Generic messaging
through the Ethernet port. Micrologix 1400 already has CIP Generic Messaging support.
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E: Detecting I/O
Communication Failures

One important function ladder logic should perform is to detect when an I/0 communication failure
occurs. This function is crucial so the control system may properly react and notify when such a
failure occurs.

When using implicit messaging, the PLC automatically restores the communications with the I/0
units. This automatic nature allows the ladder to function on stale values even when the
communication fails.

The only physical indicator of this failure on the PLC is the blinking I/O Status indicator on the front
panel. If the panel is out of reach or is not convenient to be inspected, a failure will go unnoticed.

Detecting the I/0 Status Indicator State

ControllLogix and CompactlLogix provide a way to gain access to the value that controls the 1/0
Status indicator on the front panel of the Logix controller. The command is the GSV or Get System
Value instruction.

The following GSV instruction options allow the retrieval of the I/0 Status indicator. This front panel
PLC indicator offers a global status of all module connections.

When implementing the GSV instruction, use these attributes:

Attribute Description
Class Name: “Module”
Instance Name: leave blank

Attribute Name: “LedStatus”

Destination: An INT variable to receive the status

Here is an RSLogix screen capture of a configured GSV instruction to read the module’s LedStatus.

GSV
Get System Value
Class Name Module
Instance Name
Attribute Name LedStatus
Dest 10_Led_Status
0+
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The return values are (excerpted from Allen-Bradley document 1756-RM003):

Value | pescription
0 LED Off: No.MODULE objepts are configured for the controller (th(_are are
no modules in the I/O Configuration section of the controller organizer).
1 Flashing red: None of the MODULE objects are Running.
2 Flashing green: At least one MODULE object is not Running.
3 Solid green: All the Module objects are Running.

Detecting Each Generic Ethernet Module’s State

Many system integrators will want to know precisely which /0 module failed. RSLogix provides the
ability to check on the status of each Generic Ethernet Module. This is another extension of the GSV
command.

To inspect the current status of the Generic Ethernet Module, additional ladder instructions need to
be added for each module in the PLC configuration.

These are the arguments for the GSV module:

Argument Description

Class Name: “Module”

Instance Name: The Generic Ethernet Module you want to test.

Attribute Name: EntryStatus

Destination: An INT variable to receive the bitmask.

Here is a screenshot of the GSV instruction configured within the Ladder. The Instance Name
"PACLC"is a Generic Ethernet Module already defined within the ladder.

GSV
Get System Value
Class Name Module
Instance Name PACLC
Attribute Name EntryStatus
Dest Module_Status
[

The GSV instruction may add a burden to the ladder’s scan time. As a result, the detection of I/0
failures should be implemented efficiently. Consider using a timer as a time period check to evaluate
the status of the PLC's I/0 indicator. If this indicator should indicate a failure, then a routine should
be called to test the status of the I/0 units. Calling a routine after knowing there is a failure will
reduce the number of GSV and conditional tests the ladder will have to perform.

For more information on the expected values reported by this instruction, see Allen-Bradley form
1756-rm003.
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F: Generic Ethernet Module
Options

When creating a GENERIC-ETHERNET module, you may select the Comm Format. This field controls
the assumed type and the amount of data that may be transacted on this module. The
communications format selection is dependent on the data type and the amount of data that your
E/IP configuration will read or write.

New Module Fz|
Type: ETHERMET-MODULE Generic Ethemet Module
Yendar: Allen-Bradley
Parent; EMBTA
Mame: Connection Farameters
Azzembly )
Description: Ihstance: Size:
Input; 125 J;I [32-bit]
Output; 124 ;| [32-hit)
Comrmn Format: |Data -DINT ﬂ : . = s
Configuratior: 0 = e
ddress  H{IEERTT . ~ ? = Bl
ata - - With Status
& |PAddie{paes - INT
Data - INT -"wfith Status bt
" Host Name: |
[¥ Open Module Properties oK | Cancel | Help |

Once this dialog is completed, the Comm Format cannot be changed, so make this data selection
decision carefully.

Data Selection for the Communication Format

For I04AB, the communication format data type will usually be REAL (4-Bytes), DINT (32-bit
integers), or INT (16-bit integers). The selected data type always applies to both the input and
output assembly. Should a communication format be chosen with the status input assembly, this
data is always considered a DINT format.

The four primary communication format types are as follows:

Input Data. A single assembly instance of inputs from the SNAP PAC I/0.
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DETERMINING THE NUMBER OF ASSEMBLY INSTANCES

Input Data with Status. Two assembly instances. The primary Input instance’s data may be
selected. The status assembly instance is assumed to be DINT.

Data. This is the most typical selection. There is an input assembly and an output assembly. The
user may select the data type for the input and output assembly.

Data with Status. Maximum data transfer possible. There is an input, output, and a status
assembly. The user may select the native data type for the input and output assemblies. The status
assembly is assumed to be a DINT.

The following table describes the communication format data types available for the Opto 22 1/0 for
A-B implementation.

Comm Format | Typical Use

The assembly instances are only comprised of REAL values or

REAL scaled engineering units of analog inputs or outputs.
DINT The assembly instances contain any BOOL type data (for digital
inputs or outputs).
INT The assembly instances are filled with analog inputs as type

“value” (32-bit integer in the E/IP configurator) and Boolean values.

Use the data type in the communication format that is closest to the data contained in your
assembly instances.

Determining the Number of Assembly Instances

An RSLogix ETHERNET-MODULE, Generic Ethernet Module may have at least one and up to three
assemblies of data. The three assembly types are Input, Output, and Status Input. An Input assembly
is required for all configurations. Most Module configurations will have two assemblies, Input and
Output. If additional Input data is required than Input assembly’s 125 32-bit DINT limit, you may use
the Status Input for additional data. The status input will permit up to 124 32-bit words in DINT

format only.
Assembly Max (Quantity of DINTs) Description
Input 125 Input data from the remote I/O unit.
Output 124 Output data to the remote 1/O unit.
Status Typically two less than thg size Stgtus inpgt data from the remote 1/0
of the Output Assembly Size. unit. Data is always in DINT format.
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APPENDIX F: GENERIC ETHERNET MODULE OPTIONS

Opto 22’s Mixed Architecture and the A-B Comm Format

Opto 22's architecture is based around a mixed analog and digital architecture so that assembly
instances usually have a combination of digital and analog data.

Since the Comm format will force the entire assembly to be represented as a single data type, this
means that some of the values are not adequately represented. For example, a REAL will be
contained in a DINT (bitwise) and vice versa.

RSLogix contains some methods to convert the data types.

Using CPS with Simple Data Types

For cases where the there is a minority data type in an assembly the ladder command, the CPS
command may be used to translate a REAL contained in a DINT to a REAL. The same applies if a DINT
was contained in a REAL. It may be converted to a DINT by using the CPS command.

In this case, the CPS command is a 4-byte transfer. The instruction does not convert the data, rather
it moves the binary value of the variable to the destination.

Using CPS with a UDT

If there are many mixed data types in the assembly instance, CPS may be used to copy the entire
module data array to (or from) a user-defined data type (UDT). The UDT's definition must perfectly
align to the assembly’s data types.

|IO4AB User's Guide



USING CPS WITH A UDT
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G: Accessing Serial Data

While it is possible to use I04AB with a serial module, it has to be done with explicit messaging,
which is not nearly as straightforward as the normal data types that can be handled using implicit
messaging.

A better approach is to use a SNAP PAC controller to handle the communication with the SNAP PAC
serial module and make the data accessible via the SNAP PAC controller's Scratch Pad. The
Allen-Bradley controller can then access the data in the Scratch Pad using the normal implicit
messaging method.

To use this approach you will need to develop a small PAC Control strategy to communicate directly
with a SNAP serial module on one of the controller and I/O unit combinations:

o ASNAP PAC S-series controller with a SNAP PAC EB-series 1/0 unit
o ASNAP PAC R-series combination controller and I/0 unit

Follow these steps:

1. Write a small PAC Control logic strategy to communicate directly with the SNAP serial module.
Your strategy should do the following:

— Read the values from the PLC via the Scratch Pad registers and create a string message to
transmit.

- Process the serial message transmission and parse the received data using a TCP/IP
communication handle.

— Publish the data to the Scratch Pad.

— Indicate communication status using a simple 32-bit integer status value. Publish the
communication status value to the Scratch Pad registers, which can be read by the PLC.

2. Inthe EtherNet/IP Configurator, add the Scratch Pad registers to an EtherNet/IP assembly
instance so that the PLC can read the data from the Scratch Pad. You can use either implicit or
explicit messaging to retrieve these values. For implicit message, use Generic Ethernet Module.
For explicit messaging, use a MESSAGE object and MSG instructions.

3. Tosend data from the PLC to the SNAP-PAC controller, create another assembly instance on the
controller to allow the PLC to write data (numeric or string) to the SNAP-PAC controller's
Scratch Pad registers. Again, you can use either explicit or implicit messaging."

For an example of how to exchange data between the PLC and a PAC Controller, see Chapter 6:
Connecting PAC Control and Allen-Bradley Systems on page 57.
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